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 Các Lưu ý An Toàn
 (Đọc kỹ hướng dẫn trước khi thực hành với thiết bị)

Trước khi thiết kế hệ thống, người thực hành phải đọc kỹ hướng dẫn 
sử dụng và các lưu ý về an toàn.
Đồng thời, phải đảm bảo đọc kỹ các lưu ý dưới đây để sử dụng thiết bị 
đúng thao tác.

  Để ngăn ngừa điện giật, không chạm tay vào các đầu nối khi nguồn 
đang MỞ.

  Trước khi tháo nắp an toàn của thiết bị, phải TẮT điện nguồn và kiểm 
tra xem nguồn điện đã trong trạng thái an toàn chưa trước khi thao 
tác.

  Không đặt tay vào các chi tiết đang chuyển động.

[Lưu ý khi Thực hành]

Cảnh báo

  Khi thực hành với thiết bị, phải tuyệt đối tuân theo hướng dẫn của giảng viên.

  Không được tự ý tháo môđun thiết bị thực hành hoặc thay đổi kết nối điện khi 
chưa được phép vì có thể làm hỏng hóc thiết bị, thiết bị hoạt động sai chức 
năng, hoặc gây ra thương tích, cháy nổ.

  Luôn TẮT điện nguồn trước khi tháo lắp mô đun. Tháo lắp mô đun khi điện 
nguồn vẫn đang mở dễ gây ra hỏng hóc, điện giật.

  Nếu phát hiện có dấu hiệu bất thường từ thiết bị như thiết bị phát ra âm thanh 
hay mùi lạ (như từ bàn điều khiển X/Y) phải ngay lập tức TẮT điện.

  Nếu phát hiện những dấu hiệu bất thường từ thiết bị, phải ngay lập tức liên 
hệ với giáo viên hướng dẫn. 

LƯU Ý

   
   Chú ý : Các bộ đào tạo hệ thống dây điện và bộ đào tạo PLC là cho nguồn điện 

AC100V, KHÔNG sử dụng các loại nguồn điện khác vì có thể gây rắc rối hoặc cháy.    
   Vui lòng sử dụng với một biến áp phù hợp.
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  Tài liệu này giới thiệu các kiến thức cơ bản cho người mới bắt đầu tiếp 
xúc với PLC thông qua các ví dụ đơn giản. 
  Các mô tả trong tài liệu này trích dẫn chủ yếu theo Giáo trình Hướng 
dẫn Sử dụng Thiết bị thực hành FX-I/O-DEMO2 của PLC dòng FX3G – 
14MR/ES.

 Tài liệu liên quan:
■ Thiết bị chính Của Dòng FX3G

Tài liệu Hướng dẫn Sử dụng Phần cứng của Dòng FX3G   ·······················JY997D33401
Tài liệu Hướng Dẫn Sử dụng Dòng FX3G (Chuyên đề Phần Cứng) ·········JY997D31301

■ Lập trình
Tài liệu Hướng Dẫn Lập Trình Dòng FX3G/FX3GC/FX3U/FX3UC (Chuyên đề giải thích các 
Lệnh cơ bản và Lệnh ứng dụng)   ··························································· JY997D16601

■ Bảng Lập Trình Cầm Tay
Tài liệu Hướng Dẫn Cài Đặt FX-30P··························································JY997D34201
Tài liệu Hướng Dẫn Vận Hành FX-30P······················································JY997D34401

LỜI NÓI ĐẦU

  Tài liệu này không có tác dụng đảm bảo hay cấp phát quyền sở hữu 
công nghiệp hay các quyền lợi có liên quan. 
 MITSUBISHI ELECTRIC CORPORATION không chịu trách nhiệm 
cho bất kỳ tranh chấp nào  phát sinh liên quan đến các quyền sở hữu 
công nghiệp do việc sử dụng các nội dung mô tả trong tài liệu này.

・ Windows, Windows 7, Windows 8 là thương hiệu đã được bảo hộ của Microsoft 
Corporation tại Hoa Kỳ và các quốc gia khác.
・ Tên công ty và tên các sản phẩm sử dụng trong tài liệu này là các thương hiệu đã 

được bảo hộ.

© 2014 MITSUBISHI ELECTRIC CORPORATION

Thương hiệu
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Làm quen với Điều khiển Tuần tự

"ĐIỀU KHIỂN TUẦN TỰ" LÀ GÌ?
Trong chương này, chúng ta sẽ làm quen với PLC - một thiết bị hỗ trợ Điều khiển 
tuần tự.
Đầu tiên, thế nào là “Điều khiển tuần tự”?
“Điều khiển tuần tự” là một thuật ngữ mới mẻ với nhiều người. Tuy nhiên, trên 
thực tế, nó được sử dụng khá phổ biến trong đời sống. 
Một chiếc máy giặt tự động là ví dụ điển hình của "Điều khiển tuần tự". Trong 
chương này, chúng ta sẽ nghiên cứu về khái niệm “Điều khiển tuần tự” dựa trên 
những ứng dụng của nó trong đời sống.

"ĐIỀU KHIỂN TUẦN TỰ" LÀ GÌ?
Chương 1
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1.1 Thế nào là "Điều Khiển Tuần Tự"?
"Tuần tự” là gì ?
“Điều khiển Tuần tự”: là một thuật ngữ mới mẻ với nhiều người. Tuy nhiên, trên 
thực tế, nó được sử dụng phổ biến trong đời sống, hầu như ai trong chúng ta 
cũng đã từng tiếp xúc.

Trong từ điển, khái niệm "Tuần tự" được mô tả như sau:

Như vậy, "Tuần tự" ám chỉ các sự kiện xảy ra liên tục hoặc trình tự mà các hiện 
tượng xảy ra.

Các ví dụ thực tế
Dưới đây là ví dụ về trạm rửa xe tự động thường gặp ở các trạm xăng.

(1) Trạng thái hoặc sự kiện xảy ra liên tiếp

(2) Sự kiện nối tiếp

(3) Theo trình tự nhất định

(4) Chuỗi các sự việc, kết quả diễn ra liên tục.... 

Bỏ tiền vào và nhấn nút
STAR

T.

Trư
ớ

c tiên, xe sẽ đư
ợ

c rử
a

 bằng nư
ớ

c.

Sau đó,bụi và bùn được làm
 sạch bằng xà phòng. 

C
hà sạch bằng bàn chải 

xoay lớn.

S
au đó rử

a sạch lại bằng
 nư

ớc.

N
ước được làm

 khô và việc 
rửa xe kết thúc.

Sequence

START

STOP
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Trong ví dụ nói trên, trình tự hoạt động của thiết bị rửa xe tuy đơn giản nhưng đã 
phản ánh rõ nét mô hình hoạt động cơ bản của “Tuần tự”. Nói cách khác, việc 
cài đặt thiết bị rửa xe lặp đi lặp lại các quy trình chuẩn xác với số lần không giới 
hạn theo đúng ý đồ ban đầu của người thiết kế được gọi là “Điều khiển tuần tự”.

Ngày nay, điều khiển tuần tự được sử dụng rộng rãi và đang trở thành một phần 
không thể thiếu trong tất cả các lĩnh vực của đời sống.

Điều khiển tuần tự được sử dụng rộng rãi từ những lĩnh vực phức tạp đến các 
ứng dụng đơn giản trong đời sống.

Thiết bị FA (tự động nhà máy) trong nhà xưởng

Điều khiển băng tải,thiết bị xử lý và lắp ráp.

•  Máy giặt  khổ lớn
• Máy bán vé tự động
• Thiết  b ị  đông lạnh, làm lạnh

• Điều khiển bãi  đậu xe                
•  Điều khiển cửa cuốn.
•  Điều khiển băng chuyền chở hàng
• Điều khiển cống van thủy lợi
•  Điều khiển nhà kính  
•  Điều khiển đèn t ín hiệu giao thông 
  và th iết  b ị  chiếu sáng trang tr í .     

Thiết bị sản xuất, chế biến thực phẩm

 Ứng dụng trong tự động hóaThiết bị ứng dụng trong những ngành khác

0 0 0 0 0

0 0 0 0 0

0 0 0 0 0

0 0 0 0 0

0000Ticket

Điều khiển các thiết bị sản xuất khác nhau trong xử lý 
nguyên vật liệu, tạo hình, gia nhiệt, cắt, đóng gói, các 
quy trình khác.

Điều khiển tuần tự được sử dụng phổ biến trong nhiều lĩnh vực.
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START

STOP

1.2 Các thiết bị thành phần của Điều Khiển Tuần Tự
Các thiết bị thành phần của Điều khiển tuần tự
Nhìn chung các thiết bị chính trong điều khiển tuần tự được phân loại như sau:
• "Các thiết bị vận hành bởi ngườil"
• "Các thiết bị thông báo trạng thái máy"
• "Các thiết bị dò trạng thái máy"
• "Các thiết bị vận hành máy"

Máy rửa xe tự động là một thiết bị điều khiển tuần tự được 
vận hành bởi rất nhiều thiết bị khác nhau.

Thiết bị do người vận hành Thiết bị thông báo trạng thái máy

Thiết bị vận hành máy

Người

Nút nhấn,... Đèn hay còi báo,...

Các bơm nạp xà phòng hoặc
nước và các động cơ quay 
các bàn chải…

Điều khiển

  Thiết bị do người vận hành    Thiết bị kiểm tra trạng thái máy

Các nút Khởi động/Dừng,...

          Thiết bị thông báo trạng thái máy

Đèn báo xe đang chạy,….

Công tắc dò xe đến…
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Hình vẽ dưới đây mô tả một ví dụ đơn giản trong vô số các ứng dụng đa dạng 
của điều khiển tuần tự trong đời sống. 
Điều khiển tuần tự được sử dụng nhằm điều khiển thiết bị vận hành theo một 
trình tự lập trình sẵn trên cơ sở sử dụng kết hợp các thiết bị như trên.
Trong đó, "Thiết bị vận hành bởi người" và "Thiết bị dò trạng thái máy" là các 
điều kiện cần để vận hành thiết bị trong điều khiển tuần tự, trong khi "Thiết bị 
thông báo trạng thái máy" và "Thiết bị làm máy chuyển động" là các thiết bị được 
vận hành theo các điều kiện này.

Bảng vận hành---------- Là thiết bị có lắp đặt sẵn "Thiết bị vận hành bởi 
người" (công tắc nút nhấn, công tắc chọn chế độ...) 
và "Thiết bị thông báo trạng thái máy" (đèn, màn hình 
số...).

Bảng điều khiển -------- Là thiết bị lắp đặt sẵn các công tắc điện từ, rơle và 
PLC... dùng cho việc điều khiển chuyển động của 
máy.

Công tắc tơ điện từ hoặc Rơle

   Thiết bị kiểm tra trạng thái máy Thiết bị vận hành máy
Máy móc

  Công tắc hành trình hay công tắc 
                      tiệm cận

  Động cơ hay van điện từ 

Các thiết bị tải nhỏ như các van điện từ 
loại nhỏ và các đèn điều khiển có thể 
được dẫn động trực tiếp bằng PLC, tuy 
nhiên các thiết bị tải lớn như van điện từ 
loại lớn phải được dẫn động thông qua 
một côngtăctơ điện từ hoặc rơ le.

tuần tự
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1.3 Linh Kiện dùng trong Điều khiển tuần tự
Tìm hiểu chi tiết về Điều khiển tuần tự.
Dưới đây, chúng ta hãy cùng xem xét về Điều khiển tuần tự dựa vào Sơ đồ nối 
dây bên dưới. Ngoài ra, chúng tôi sẽ trình bày về các thuật ngữ mà các bạn cần 
biết về Điều khiển tuần tự.

 Ví dụ 1        Mạch điện bên dưới được đấu nối bằng cách sử dụng công tắc nút                           
  nhấn, đèn (xanh da trời, đỏ)..
    Nội dung của Điều khiển tuần tự
(1) Khi không nhấn công tắc, dòng điện chạy theo đường B và đèn xanh phát  
     sáng.
(2) Khi nhấn công tắc, dòng điện chạy theo đường A và đèn đỏ phát sáng.
(3) Khi nhả công tắc, đèn xanh phát sáng như Mục ①.
   Vận hành nêu tại Mục ① và Mục ③ nói trên là một phần của Điều khiển tuần 
tự.

Sơ đồ kết nối

Đèn xanh

Đèn đỏ

Rơ le

  Nút nhấn

Nguồn điện

Nguồn điện

A

B
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    Các loại tiếp điểm
Tiếp điểm đóng vai trò thực hiện các hoạt động chuyển mạch cho phép hoặc ngăn cản dòng 
điện thông qua thao tác đóng mở. Có hai loại tiếp điểm cơ bản là “Tiếp điểm N.O” (Normal 
Open: Tiếp điểm thường mở) và “Tiếp điểm N.C.” (Normal Close: Tiếp điểm thường đóng). Các 
công tắc, rơle, bộ hẹn giờ, bộ đếm và các thiết bị khác sẽ có các tiếp điểm.

"Tiếp điểm N.O." là một tiếp điểm "thường mở" và đóng khi tiếp điểm được 
kích hoạt.

"Tiếp điểm N.C." là tiếp điểm "thường đóng" và mở khi được kích hoạt.

Nút nhấn

        Nút nhấn

Tiếp điểm di chuyển

Tiếp điểm di chuyểnTiếp điểm 
di chuyển

Tiếp điểm di chuyển

Nút nhấn

  Nút nhấn

Tiếp điểm cố định

Tiếp điểm cố định

Tiếp điểm cố định

Dòng điện

Dòng điện

Tiếp điểm cố địnhĐấu dây

Đấu dây Đấu dâyĐấu dây

Đóng 
mạch   Hở 

mạch

Đấu dây

Tiếp điểm 

Đấu dây Lò xo

Lò xo Lò xo

Trước khi nhấn nút (ở vị trí trở về)          Sau khi nhấn nút (ở vị trí vận hành)
Lò xo

  Hở 
mạch

 Lưu ý 1 : "Kích hoạt" tức chuyển từ trạng thái nghỉ thông thường sang trạng thái hoạt động cưỡng 
                bức.Hoạt động nhấn nút tương đương với việc kích hoạt.

Tiếp điểm N.O.

Tiếp điểm N.C.

Vận hành: Trong trường hợp công tắc nút nhấn
                   Khi không nhấn nút nhấn, tiếp điểm mở. 
                   Khi nhấn nút nhấn, tiếp điểm đóng.

Vận hành: Trong trường hợp công tắc nút nhấn
                   Khi không nhấn nút, tiếp điểm đóng.
                   Khi nhấn nút, tiếp điểm mở.

Thuật ngữ Tuần tự.
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    Rơle
Rơle (Relays) theo nghĩa của từ này có vai trò đóng ngắt dòng điện.Trên thực tế, trong rơ le có 
chứa một nam châm điện, thông qua chuyển động của nam châm điện này, rơle sẽ kéo tiếp 
điểm di chuyển để mở hoặc đóng tiếp điểm*.

Tiếp điểm 
di chuyển

Tiếp điểm 
di chuyển

Dòng điện chạy qua tiếp điểm.

Tiếp điểm cố định Tiếp điểm cố định

Dòng điện

Lò xo

Khi điện chạy qua nam 
châm, tiếp điểm di chuyển 
được kích hoạt.

Khi điện ngừng chạy qua, tiếp điểm 
di chuyển trở về vị trí ban đầu do có 
lò xo.

 

Tiếp điểm OFFTiếp điểm ON

Tiếp điểm N.C. (thường đóng)

Tiếp điểm 
di chuyển

Tiếp điểm 
di chuyển Dòng điện chạy qua tiếp điểm.

Tiếp điểm 
cố định

Nam châm điện
Nam châm điện

Nam châm điện
Nam châm điện

Dòng điện trong 
cuộn dây.

Lò xo

Khi điện chạy qua nam 
châm, tiếp điểm di chuyển 
được kích hoạt.

Khi điện ngừng chạy qua, tiếp điểm 
di chuyển trở về vị trí ban đầu do có 
lò xo.

Tiếp điểm OFF
Tiếp điểm ON

Tiếp điểm N.O. (thường mở)

*Tiếp điểm: Ở đây, “Tiếp điểm” làm phần diện tích tiếp xúc thực hiện hoạt động chuyển mạch, dẫn hoặc ngăn cản  dòng điện. 
Ngoài rơle còn có các công tắc, bộ hẹn giờ, bộ đếm và các thiết bị khác có chứa các tiếp điểm. Tiếp điểm chủ yếu 
được phân loại thành tiếp điểm N.O. (thường mở) và tiếp điểm N.C. (thường đóng) (như đã mô tả ở trang trước).
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     Rơle được sử dụng ở đâu?
(1) Rơle có thể làm cho các động cơ lớn và đèn hoạt động bằng việc dùng các 
tín hiệu nhỏ..

(2) Rơle có thể làm cho các động cơ và đèn ở khu vực xa hoạt động.

 12 V DC(dòng một chiều)

100 V AC(dòng xoay chiều)
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Sơ đồ 1. Đèn xanh

Cấu hình sản phẩm

1.4 Thực hiện nối dây trong Điều khiển tuần tự
Dựa theo thuật ngữ đã học
Chúng ta hãy cùng thực hành Ví dụ 1 nêu 
trong trang 8 về tiếp điểm Rơ le.
    Khái quát về thiết bị thực 
hành nối dây Rơle

Cáp nguồn 1 pc
Nút nhấn 1 pc
Đèn xanh 1 pc
Đèn đỏ 1 pc
Rơ le 1 pc
Bộ dây nối (nâu, đỏ, cam, vàng,xanh lá cây, 
xanh da trời, tím, xám) ･･･ mỗi thứ 1 bộ 

Lưu ý) Trong ví dụ này, các  đầu  nối  nguồn
             số 4 và  số 5 là  các  đầu  nối  chung.

*1  Thế nào là “ Sơ đồ đấu nối dây” thực tế ?

   Thực hành nối đây trên thiết bị thực hành Demo:
1. Kiểm tra xem nguồn điện đã ở trạng 
    thái OFF hay chưa.
2. Nối dây cho đèn xanh da trời ở Hình 1 
    như sau:
    Dây tím vào đầu nối số 7
    Dây vàng vào đầu nối số 4
    Dây xám vào đầu nối số 8
3. Nối dây cho đèn đỏ ở Hình 2 như sau:
    Dây xanh lá vào đầu nối số 5
    Dây xanh da trời vào đầu nối số 6
    Dây nâu vào đầu nối số 1
    Dây đỏ vào đầu nối số 2
    Dây cam vào đầu nối số 3

Sơ đồ đấu nối dây thực tế là sơ đồ 
thể hiện mô hình nối dây và mạch 
điện gần nhất với mô hình thực 
tế.Thông qua Sơ đồ đấu nối dây thực 
tế, người thao tác có thể biết chính 
xác vị trí của dây nối và cấu trúc thiết 
bị, nhờ đó có thể thao tác hoặc bảo 
trì thiết bị một cách dễ dàng.

Đèn đỏ
Đèn xanh

Rơ le

Nút nhấn

Nguồn điện DC

Common 
contact N.C. contact Relay

Coil

Pushbutton

Pushbutton switch
N.O. contact

100 V AC

Sơ đồ 2. Đèn đỏ

     Sơ đồ nối dây *1

Common 
contact N.C. contact Relay

Coil

Pushbutton

Pushbutton switch
N.O. contact
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Tới đây bạn đã học được một số khái niệm về tuần tự
  Kiểm tra vận hành của máy :
    Trên cơ sở những nội dung đã học về điều khiển tuần tự từ trang 8, hãy điền vào 
chỗ trống các thuật ngữ tương ứng.
(1) Khi nguồn điện được MỞ, tiếp điểm thường đóng và đường B được thiết lập, đèn 

xanh phát sáng.
(2) Khi nhấn công tắc nút nhấn (tiếp điểm thường đóng), tác dụng của rơle làm cho 

tiếp điểm thường mở đóng lại. Đường A được thiết lập và đèn đỏ được mở.
(3) Khi thả công tắc nút nhấn, đèn xanh lại phát sáng như Mục (1) nêu trên.

"Sơ đồ khối" là gì?
Với điều khiển tuần tự, các thiết bị khác nhau được kết nối để tạo thành mạch 
điện.Do đó, trong trường hợp cần thể hiện chi tiết trình tự hoạt động của các 
thiết bị, mô hình tổng thể sẽ rất khó hiểu và phức tạp.
Khi đó Sơ đồ khối được sử dụng nhằm đơn giản hóa quy trình hoạt động tổng 
thể thông qua các “Mũi tên” và “Tứ giác”.

"Biểu đồ thời gian" là gì?
Biểu đồ thời gian diễn đạt những thay đổi trong tuần tự vận hành theo thời gian.
Các thiết bị được điều khiển được thể hiện trên trục đứng, trong khi các thay đổi 
theo thời gian được thể hiện trên trục ngang. Các mũi tên kẻ đứt dùng để thể 
hiện hoạt động của từng thiết bị tương ứng.
Biểu đồ thời gian đôi khi diễn tả những thay đổi theo thời gian mà không dùng 
mũi tên.

Bạn cũng có thể học nội dung của điều khiển tuần tự từ các sơ đồ khối và biểu đồ 
thời gian.

Mở nguồn Bạn đang nhấn 
nút nhấn ?

Đèn xanh: ON
Đèn đỏ: OFF

Bạn không nhấn 
nút nhấn?

Đèn xanh: OFF
Đèn đỏ: ON

   Tuần tự diễn đạt theo sơ đồ khối

Tuần tự được diễn đạt theo biểu đồ thời gian

KHÔNG

Nút nhấn

Rơ le

Nhấn nút nhấn

Đang vận hành

Sáng

Sáng Sáng

Đóng

Thả nút nhấn

Đèn xanh

Đèn đỏ

Nút nhấn

KHÔNG

CÓ

CÓ

Rơ le
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Sơ đồ nối dây thực tế là sơ đồ hỗ trợ hiệu quả về dây nối và cấc trúc thiết bị trong 
những trường hợp đơn giản. Tuy nhiên, trong các mạng điện phức tạp, việc sử dụng 
Sơ đồ nối dây có thể gây khó hiểu cho người thao tác.
Do đó dưới đây chúng tôi sẽ sử dụng Sơ đồ tuần tự để minh họa.

Sơ đồ tuần tự là sơ đồ đơn giản hóa cách thức vận hành của mạch theo thứ tự 
vận hành. Cách thể hiện của Sơ đồ tuần tự đã được quy chuẩn hóa, do đó thuận 
tiện cho việc sử dụng của cả bên thứ ba.

Chú ý) Với thiết bị thực hành FX-I/O, 
đèn và rơ le đều dùng nguồn điện 
24V. Tuy nhiên, nhìn chung, rơ le 
thường được điều khiển bằng 
dòng điện DC 24 V, còn đèn sử 
dụng dòng điện AC 100V như thể 
hiện trong Sơ đồ sau.

    Sơ đồ nối dây thực tế và Sơ đồ tuần tự

Sơ Đồ Nối Dây

Sơ Đồ Tuần tự 

RƠ LE
PB

Nguồn DC

Công tắc nút nhấn Cuộn dây Rơle

XANH

ĐỎ
Xanh

Đỏ

Nguồn AC

RƠ LE (Tiếp điểm N.C.)

RƠ LE (Tiếp điểm N.O.)
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Một ví dụ khác.

Bơm tiếp vận
Bơm

Giếng

Bồn

LS2 (tiếp điểm N.C.) hoạt động 
khi bồn đầy nước, tiếp điểm mở.
Công tắc hành trình.

LS1 (tiếp điểm N.O.) hoạt động
 khi bồn cạn nước, tiếp điểm đóng. 
Công tắc hành trình.

 Ví dụ 2        : Điều khiển mực nước trong bồn.
    
     Nội dung Điều khiển Tuần tự
(1) Khi đóng công tắc vận hành, công tắc hành trình của phao 1 đóng nếu bồn 

cạn nước, sẽ làm vận hành công tắc từ MC để dẫn động động cơ bơm tiếp 
vận.

     Rơle MC được thiết kế để tự giữ trạng thái ngay cả khi mực nước trong bình 
tụt xuống mực giữa.

(2) Rơle MC được thiết kế để tự giữ trạng thái ngay cả khi mực nước trong bình 
tụt xuống mực giữa.

(3) Khi mực nước chạm mức cạn bồn, động cơ bắt đầu hoạt động tự động trở 
lại.

M

Công tắc tơ từ MC 

Công tắc khởi động

ON

OFF
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Nguồn
 động
   cơ

Nguồn điều khiển

Công tắc khởi động

Công tắc khởi động
vẫn MỞ ngay cả 
khi nhả công tắc. 
(loại vận hành chốt).

Mô tơ

Động cơ được dẫn 
động khi rơle đóng.

*Cầu dao

Công tắc 
khởi động Mực nước 

đầy Mực nước giữa

Vận hành

Mực nước giữa Mực
 nước cạn

Mực nước giữa

Công tắc 
phao LS2
Công tắc 
phao LS1
Công tắc 
từ 

Tuần tự trong phần này thường được thay thế bởi một chương trình tuần tự trên PLC.

Về các mạch tự giữ
"Mạch tự giữ" là mạch vận hành mà các tín hiệu nối tắt đến từ một rơle 
ngoài hoặc thiết bị khác bằng tiếp điểm của chính rơle.
Có thể nói các mạch tự giữ cũng có chức năng bộ nhớ cho phép chúng hoạt 
động liên tục dù mạch bị ngắt khi thả công tắc đang nhấn.
Trong mạch này, tiếp điểm của rơle (MC*2) để dẫn động động cơ được nối 
song song với công tắc hành trình phao 1 (LS1). Đây là một ví dụ về "công 
tắc tự giữ".

Mặc dù công tắc hành trình 2 (LS2) có chức năng ngắt mạch tự giữ để dừng 

động cơ bơm tiếp vận, khi công tắc hành trình 2 (LS2) được sử dụng với một tiếp 

điểm N.C., công tắc này cũng có thể được TẮT để ngừng chuyển nước khi công 

tắc không tiếp xúc hoặc hở kết nối dây.

   Sơ đồ tuần tư

Tác động của các mạch tự giữ (biểu đồ thời gian)

*Cầu dao      Có tác dụng làm ngắn
                      mạch khi dòng quá lớn

*1

*2

*3

Tiếp điểm N.O. Công tắc phao MỞ
khi bồn cạn nước.

Công tắc từTiếp điểm N.C. 

Công tắc phao 
TẮT khi bồn 
đầy nước.

Tiếp điểm N.C. 

Ngay cả khi công tắc 
phao LS1 TẮT, hoạt 
động của công tắc từ 
MC vẫn tiếp tục do 
mạch tự giữ.

Mực nước 
đầy

MC

MC
M

MC

MC*2

LS2 *3
LS1

*1
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Phân loại Tiếp Điểm

Phân loại Sản Phẩm

Tiếp điểm thường mở Tiếp điểm thường đóng
Nguồn dẫn động

Kiểu ngang Kiểu đứng Kiểu ngang Kiểu đứng

Công tắc nút    
nhấn (loại tự 

động) Bằng tay

Công tắc nút 
nhấn (loại vận 

hành chốt)
ON

OFF
Bằng tay

Rơle nhiệt
(OCR)

Vận hành

Điện trở nhiệt

Công tắc 
thông thường Bằng tay

Công tắc 
hành

trình (vận 
hành cơ khí)

Bánh 
cóc Cam

Tiếp điểm rơ 
le công tắc 

phụ trợ

Cuộn điện từ

Công tắc từ

Bộ hẹn giờ
(ON delay)

Bộ hẹn giờ
(OFF delay)

1.5 Các Ký Hiệu Tuần Tự
Các ký hiệu tuần tự chính

(JIS C 0617)
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MEMO



Làm quen với PLC

"PLC" là gì?
PLC là viết tắt của cụm từ "Programmable Controller (Điều khiển có thể lập 
trình)" còn được gọi là "Sequence Controller” (SC : Điều khiển Tuần tự). 
PLC được định nghĩa là các thiết bị điện tử điều khiển các thiết bị khác 
nhau thông qua các ngõ vào và ngõ ra I/O và có bộ nhớ trong để lưu trữ 
các lệnh có thể lập trình.

Trên thực tế…
Như chúng ta đã biết ở chương trước, PLC là thiết bị giúp thực hiện “Điều 
khiển tuần tự” thông qua các chương trình đơn giản bằng việc nối dây cho 
rơ le và bộ hẹn giờ. 

"PLC" LÀ GÌ?
Chương 2
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2.1 "PLC" là gì ?
Vai trò của PLC ?

Người

Các công tắc... Các đèn, còi...

Các động cơ,van...

Các thiết bị thông báo cho người 
vận hành về trạng thái máy.

Thiết bị vận hành 
bởi người.

Điều khiển tuần tự
Thiết bị làm máy 
chuyển động

    Máy

Thiết bị làm máy 
chuyển động

Trong Điều khiển Tuần tự, các thiết bị được vận hành bởi người hoặc Thiết bị 
kiểm tra trạng thái máy trong được gọi là "Tín hiệu chỉ dẫn" hoặc "Tín hiệu điều 
kiện".Các thiết bị thông báo cho người vận hành về trạng thái máy hoặc làm máy 
chuyển động được gọi là "Tải".

Trong sơ đồ trên, PLC nằm ở vị trí của "Điều khiển tuần tự", đóng vai trò điều 
khiển các thiết bị. Đồng thời, PLC cũng là thiết bị giúp thực hiện “Điều khiển tuần 
tự”.

Các cảm biến...
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2.2 Nguyên lý hoạt động của PLC
Điều khiển tuần tự hoạt động như thế nào ?

PLC là thiết bị điều khiển trên máy tính trong ngành công nghiệp.

Trong PLC, “Tín hiệu chỉ dẫn”, “Tín hiệu điều kiện” và “Tải dẫn động” được kết 
nối với nhau. Các thiết bị được kết nối tại phía vào của PLC được gọi là "thiết bị 
ngõ vào", các thiết bị được kết nối với phía ra của PLC được gọi là "thiết bị ngõ 
ra". Mỗi thiết bị được kết nối với một khối nối dây.

Một thiết bị ngõ vào và một thiết bị ngõ ra có thể được kết nối đơn giản với PLC 
như trên, các kết nối khác phục vụ điều khiển tuần tự được thực hiện bằng hình 
thức điện tử bên trong PLC.

Các kết nối bên trong PLC được lập trình bằng việc sử dụng ngôn ngữ tuần tự 
chuyên dụng (lệnh) và sự kết hợp của các lệnh này được gọi là "chương trình 
tuần tự". Điều khiển tuần tự được thực hiện theo chương trình này, vì thế không 
cần phải nối dây từ bên ngoài.

Công tắc hành trình

Tiếp điểm rơ le

Công
tắc lựa 
chọn

Công tắc nút nhấn

PLC

Thiết Bị Vào

Bảng lập trình
 cầm tayPC(Phần mềm lập trình)

Nguồn điện

G
iao diện ngõ ra

G
iao diện ngõ vào

Phần 
lưu trữ

Phần 
vận hành

Bộ nhớ

Máy vi tính

Công tắc tơ

 Đèn

Van điện từ

 (Van điện từ)

Thiết Bị Ngõ Ra

Nguồn điện
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Trên thực tế, PLC là một khối kết hợp của nhiều Rơ le và Bộ hẹn giờ

Hình trên thể hiện cách các thiết bị ngõ vào, ngõ ra và chương trình tuần tự được thiết lập.
Các thiết bị ngõ vào được kết nối với các rơle ngõ vào của PLC và thiết bị ngõ ra được điều khiển qua các tiếp điểm cho các ngõ ra thiết bị ngoài.

Rơle ngõ vào

Tiếp điểm ngõ ra

Rơle ngõ vào chuyển đổi các tín hiệu từ thiết bị ngoại vi thành các tín hiệu cho 
PLC. Trong hình trên, thiết bị ngõ vào được thiết kế để đơn thuần vận hành thông 
qua việc kết nối qua đầu nối ngõ vào và đầu nối COM.
Tuy nhiên phải lưu ý rằng mặc dù PLC có một số lượng các tiếp điểm hữu hạn, số 
lượng các tiếp điểm được cung cấp trong chương trình tuần tự là vô hạn.

PLC có nguồn điện có sẵn cho các 
rơle ngõ vào. Khi tiếp điểm của thiết 
bị ngõ vào dẫn điện, dòng điện chạy 
theo đường gạch đứt để điều khiển 
rơle ngõ vào. 

Khi các rơle ngõ ra trên chương 
trình tuần tự được điều khiển, các 
tiếp điểm cho ngõ ra ngoại vi sẽ 
đóng lại.Khi đó, các bạn hãy chuẩn 
bị nguồn điện riêng bên ngoài PLC 
để điều khiển thiết bị ngoại vi.

Bất kể thiết bị ngõ vào bên ngoài là tiếp điểm N.O. hay tiếp điểm N.C., tiếp điểm 
trên PLC đóng khi đầu nối COM và đầu nối ngõ vào dẫn điện là một tiếp điểm 
N.O. và tiếp điểm mở là tiếp điểm N.C.

Tiếp điểm ngõ ra là tiếp điểm của rơ le ngoài được điều khiển bởi chương trình 
tuần tự, đóng vai trò dẫn động một tải ngoài. Các thiết bị có nguồn điện khác 
nhau (AC hoặc DC) có thể được kết nối với tiếp điểm cho ngõ ra ngoại vi.

Rơ le ngõ vào được vận hành 
bởi tín hiệu ngoài ON/OFF

Làm vận hành chương trình
tuần tự

Truyền tín hiệu ON/OFF 
cho Rơ le ngõ ra

Tải ngõ ra được 
vận hành

 
Nguồn điện

PL

Tiếp điểm cho ngõ 
ra thiết bị ngoài

Rơ le ngõ vào

PLC

Vận hành

Vận hành

PB1

LS1

PB2

X001

Y000

X001

X005

M100

X007

K100

X003

Rơ le đầu ra

Bộ hẹn giờ

Rơ le phụ trợ

COM

X000

X001

X002

X003

X004

X005

X006

X007

X001

X003

X005

M100

T0

Y100

Thiết bị ngõ vào

COM

Rơle ngõ vào

PLC

Đầu nối ngõ vào

COM

PLC
Thiết bị ngõ ra

  Nguồn điệnTiếp điểm cho ngõ ra ngoại vi

Đầu nối ngõ ra

COM1

Y000

Y001

Y002

Y003

MC
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Số I/O được đặt cho mỗi đầu nối để nối thiết bị I/O với các đầu nối ngõ vào và 
các đầu nối ngõ ra tương ứng với các rơle ngõ vào và các rơle ngõ ra của 
chương trình tuần tự. 
Các bộ hẹn giờ và bộ đếm bên trong PLC cũng được đặt tên theo số thiết bị 
cùng với số của mỗi đầu nối.

Thiết bị ･･･  Thiết bị được phân biệt bởi ký hiệu thiết bị và số thiết bị (Số thiết bị còn 
                     được gọi là Số thành phần thiết bị).

Rơle ngõ vào hoạt động như "Cửa sổ tiếp 
xúc" để nhận tín hiệu, ví dụ như từ một công 
tắc ngõ vào ngoài PLC. Ký hiệu của thiết bị 
này là X. PLCcó trang bị đầy đủ số lượng rơle 
ngõ vào tương ứng với số lượng ngõ vào (số 
lượng đầu nối).

Rơle ngõ vào : X000~

Rơle ngõ ra hoạt động như "Cửa sổ tiếp 
xúc" để thực hiện nhận tải bên ngoài 
PLC. Ký hiệu thiết bị này là Y. PLC có 
trang bị đầy đủ số lượng rơle ngõ ra 
tương ứng với số lượng ngõ ra (số 
lượng đầu ra).

Rơle ngõ ra     : Y000~

PLC có bộ hẹn giờ riêng. Bộ hẹn giờ 
đóng vai trò đo thời gian, với các cuộn 
dây và tiếp điểm. Khi đến thời gian đã 
cài đặt, tiếp điểm sẽ đóng.

Bộ hẹn giờ  : T0~

Bộ đếm được giữ bên trong PLC và có 
chức năng đếm số. Khi đến số cài đặt, 
tiếp điểm đóng.

Bộ đếm : C0~

Trong PLC có các rơle phụ trợ còn được 
gọi là "các rơle  trong".

Số lượng các rơle ngõ vào, rơle ngõ ra, bộ hẹn giờ, bộ đếm và các thiết bị 
khác thay đổi tùy theo mô đen của PLC.

Rơle phụ trợ : M0~

Tham khảo

Số thập phân, Bát phân và Thập lục phân
Như thể hiện trong bảng sau, ngoài số thập phân, thiết bị còn sử dụng số thập 
lục phân và số bát phân.

Rơ le phụ trợ, bộ hẹn giờ, bộ đếmRơle ngõ vào, rơle ngõ ra

    Dòng phổ thông Q/A
 

    Dòng Micro PLC FX Bát phân Thập phân
Thập lục phân Thập phân

"Thập phân"

"Octal"

"Thập lục phân"

Hệ thống số thập phân được dùng phổ biến và tăng đơn vị sau mỗi 10 
điểm từ 0~ 9, 10~ 19, 20 ~ 29, …..
Hệ thống số bát phân đếm theo đơn vị 8 từ 0 ~ 7, 10 ~ 17, 20 ~ 27,...

Hệ thống số thập lục phân đếm theo đơn vị 16 như sau 0~9, 0A, 0B, 0C, 
0D, 0E, 0F, 10 ~ 19, 1A, 1B, 1C, 1D, 1E, 1F ….
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Các biểu diễn trong sơ đồ tuần tự và chương trình tuần tự
Chương trình tuần tự trên PLC là chương trình thay thế cho các thiết bị ngõ vào và thiết bị 
ngõ ra được kết nối với một trong các đầu nối ngoại vi bằng một mạch điện để thực hiện điều 
khiển tuần tự. Vui lòng tham khảo Chương 4 để biết thêm về các Lệnh trong PLC.
Phần sau đây giải thích cách thay thế một sơ đồ tuần tự bằng một chương trình tuần tự.
Ví dụ này sử dụng chương trình tuần tự để thể hiện việc điều khiển mực nước của bồn được 
mô tả ở trang 15.

Dưới đây là những điểm khác nhau khi biểu diễn một Sơ đồ tuần tự bằng một 
Chương trình tuần tự.

SW
LS2 LS1

MC

MC

MC

MC

X000 X002 X001

Y000

Y000
SW LS2 LS1 

Sơ đồ tuần tự Chương trình tuần tự

(1) Cách thể hiện tiếp điểm N.O. và N.C.
Sơ đồ tuần tự rơle Chương trình tuần tư

Tiếp điểm N.O.

(2) Trong Chương trình tuần tự không thể hiện mạch điện nguồn.
(3) Trong Chương trình tuần tự sẽ xuất hiện số các thiết bị như chúng tôi giải thích
      trong trang trước.

(4) Công tắc hành trình 2 trong sơ đồ tuần tự là tiếp điểm N.C. nhưng trở thành      
tiếp điểm N.O. trong chương trình tuần tự.

     Đấy là bởi vì chức năng của công tắc hành trình 2 trong sơ đồ tuần tự trên sẽ 
làm ngắn mạch mạch tự giữ của MC và dừng MC. Vì thế, ta nên xem rằng nó 
luôn ở trạng thái dẫn điện trên mạch điện.

    Tiếp theo, hãy nhớ hoạt động của rơle ngõ vào ở trang 22. Trong hoạt động của 
các tiếp điểm N.O.  và N.C.  trong chương trình tuần tự, các tiếp điểm N.O. 
MỞ và các tiếp điểm N.C. TẮT khi rơle ngõ vào đang dẫn điện do sự thay đổi 
trạng thái tiếp xúc ở đấu nối ngoại vi. Bởi vì điều này, tiếp điểm N.O. phải được 
sử dụng trên chương trình tuần tự để đạt được cùng trạng thái hoạt động.

     Bằng cách này, khi PLC được sử dụng, các tiếp điểm N.O. và N.C. có thể được 
sử dụng cho mỗi tiếp điểm trên chương trình tuần tự.

Khác biệt quan trọng

Tiếp điểm N.O.

Tiếp điểm N.C. Tiếp điểm N.C.
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Hoạt động của tiếp điểm N.O. và N.C. trong chương trình PLC
Phần sau đây mô tả hoạt động của tiếp điểm N.O. và tiếp điểm N.C. trong 
chương trình PLC.

•	Khi không có dòng điện chạy trong các thiết bị ngõ vào, tiếp điểm N.O. 
sẽ hoạt động như tiếp điểm “TẮT trong chương trình PLC” và tiếp điểm 
N.C. sẽ là tiếp điểm "MỞ trong chương trình". 

•	Khi có dòng điện chạy trong các thiết bị ngõ vào, tiếp điểm N.O. sẽ hoạt 
động như tiếp điểm MỞ trong chương trình PLC và Tiếp điểm N.C. sẽ 
TẮT trong chương trình.
Tương tự, đối với PLC, để đạt được hoạt động tương tự như trên Sơ đồ 
tuần tự, ta phải dùng tiếp điểm N.O. trong chương trình PLC cho tín hiệu 
của LS2.
Để biết chi tiết, vui lòng tham khảo Mục (1) và (2) bên dưới.

  Tham khảo

[1] Lý do sử dụng công tắc hành trình LS2 (X2) như một tiếp điểm N.O. trong chương trình PLC
    (1) Trường hợp công tắc hành trình LS2 được dùng như tiếp điểm N.C. như trong Sơ đồ tuần tự

Cạn

Cạn

Đầy

  Tiếp điểm N.C.

Tiếp điểm N.C. 

Tiếp điểm
   N.C. 

 Không 
dẫn điện

Dẫn điện

Không
dẫn điện Dẫn điện

Tiếp điểm N.C. 

Tiếp điểm N.O.  

Khởi động

Đầy

Khởi động

Cạn

Cạn

Trạng thái dẫn điện 
đượcchuyển đổi như 
tín hiệu “ON”.

Bơm vẫn
OFF.

Bơm vẫn
ON.

Dòng điện không chạy khi 
tiếp điểm ON.

Dòng điện chạy khi tiếp 
điểm ON.

Tiếp điểm
   N.O. 

(2) Trường hợp công tắc hành trình LS2 được dùng như tiếp điểm N.O.

●Ý tưởng lập trình
Khi tín hiệu được nhập vào từ bên ngoài, tiếp điểm N.O. sẽ dẫn điện, và tiếp điểm 
N.C. sẽ không dẫn điện.
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Cạn

Đầy

Cạn

Đầy

Khởi động

Cạn

Đầy

Khởi động

Cạn

Đầy

Khởi động

Cạn

Đầy

Khởi động

Bơm
TẮT

Bơm
TẮT

Bơm
MỞ

Bơm
MỞ

Công tắc hành trình 1 MỞ
và bơm MỞ.

Công tắc hành trình 1 TẮT,
nhưng bơm vẫn MỞ
bằng chức năng tự giữ.

Công tắc hành trình 2 MỞ,
và bơm TẮT.

[2] Điều khiển mực nước trong bồn

•	 Bơm TẮT khi nước ở mức giữa.

•	 Khi nước đến mức cạn

•	 Khi bơm MỞ và nước được cung cấp

•	 Khi nước đến mức đầy
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2.3 Đấu nối dây và lập trình
Phương thức đấu nối và lập trình PLC
Hình dưới đây phân tích mạch điện ở trang 16.

Nối dây I/O phải được thực hiện theo 
cách truyền thống sử dụng kềm cắt 
và tuôcnơvit.

Các kết nối giữa đầu nối ngõ vào và cuộn rơle ngõ vào cũng như kết nối giữa 
tiếp điểm ngõ ra của rơle ngõ ra với đầu nối ngõ ra đã được thực hiện từ trước 
đó khi sản phẩm được đưa ra thị trường.

Nối dây phức tạp bên trong PLC 
(chương trình tuần tự) có thể được 
thực hiện dễ dàng bằng cách sử dụng 
bàn phím máy tính hoặc bảng lập 
trình cầm tay.

SW

COM

X000

COM

Cầu chì

Y000 MC
X000 X002 X001

Y000

Y000

X001

X002

LS1

LS2

Đấu nối dây 
ngõ ra

Chương trình tuần tựĐấu nối dây 
ngõ vào

Việc nối dây PLC có thể chia thành nối dây I/O và nối dây bên trong.
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2.4 Các Ưu Điểm Của PLC
2.4.1 Sử Dụng Hiệu Quả PLC

1 Tính Kinh tế
PLC ít tốn kém hơn bộ điều khiển truyền thống phải dùng 10 hoặc 
nhiều hơn 10 rơle.

2 Tiết kiệm nhân sự thiết kế
PLC giúp tiết kiệm một lượng lớn nhân lực thiết kế nhờ đơn giản hóa 
quy trình thiết kế bản vẽ, bản vẽ nối dây,tiết kế tuần tự và vận hành thử.

3 Tiết kiệm nhân sự thao tác
Nhân lực thao tác được cắt giảm đáng kể nhờ cắt giảm số lượng linh kiện, quy 
trình cung ứng cùng lúc máy và bộ điều khiển, linh hoạt trong việc thay đổi 
thông số, đơn giản hóa quy trình nối dây …4 Kích thước nhỏ gọn và Tiêu chuẩn hóa
Kích thước PLC được thu nhỏ đáng kể so với bảng mạch rơle và giúp 
quy chuẩn hóa trong sản xuất hàng loạt bằng việc tái sử dụng chương 
trình thiết kế.

6 Khả năng bảo trì được cải thiện
Việc bảo trì có thể được thực hiện dễ dàng, vì ít sử dụng các linh kiện 
hao mòn và PLC có chức năng tự chẩn đoán.

5 Cải thiện chất lượng
PLC giúp giảm đáng kể những lỗi thiết bị của rơ le và bộ hẹn giờ, chỉ 
cần cài đặt ban đầu là người sử dụng có thể an tâm thao tác.
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2.4.2 So sánh với điều khiển rơle

Khái quát lịch sử PLC
"PLC" ra đời lần đầu vào năm 1968 theo yêu cầu phát triển của công 
ty General Motors (Mỹ) và bắt đầu được chào bán rộng rãi ra thị 
trường từ năm 1979. Tại Nhật Bản, PLC được sản xuất lần đầu vào 
năm 1970, tuy nhiên phải đến năm 1976 các thiết bị PLC thông dụng 
mới xuất hiện. Năm 1977, Mitsubishi Electric Corporation tung ra sản 
phẩm PLC thông dụng. Từ đó môđun PLC « một bảng mạch » trở 
thành tên gọi quen thuộc trên thị trường. Từ đó, hãng này đã phát 
triển PLC dòng K thông dụng với các chức năng xử lý số tích hợp 
mà theo sau đó là các Micro PLC dòng F trang bị sẵn bộ lập trình. 
Ngày nay có rất nhiều sản phẩm PLC khắp thế giới phù hợp với một 
chuỗi các ứng dụng điều khiển.

1
2
3
4
5
6
7
8
9

Điều khiển PLCPhương phápMục Điều khiển rơle

Chức năng

Độ tin cậy

Tính đa năng

Bảo trì

Phạm vi chức năng

Kích cỡ thiết bị

Giai đoạn thiết kế, sản xuất

PLC có thể được dùng cho bất kỳ 
điều khiển nào tùy thuộc vào 
chương trình.

Thiết bị đã sử dụng không thể 
thay thế cho mục đích khác.

Khả năng thay đổi linh 
hoạt nội dung điều khiển

PLC có thể được sửa dễ 
dàng thông qua thay đổi 
môđun.

PLC có thể được mở rộng 
tùy ý theo khả năng của thiết 
bị.

Khó, khi mở rộng cần tăng 
cường và hiệu chỉnh thiết bị.

Ngoài điều khiển tuần tự, PLC 
cũng hỗ trợ điều khiển tương tự 
và định vị.

PLC không tăng kích thước 
ngay cả với các ứng dụng điều 
khiển phức tạp và nâng cao.

Thiết kế đơn giản ngay cả với 
những điều khiển phức tạp và 
không mất thời gian sản xuất PLC.

Cần nhiều bản vẽ và thời gian 
sắp xếp linh kiện và lắp ráp. 

Chỉ hỗ trợ điều khiển rơle.

Cần nhiều bản vẽ và thời 
gian sắp xếp linh kiện và lắp 
ráp. 

PLC giúp hỗ trợ các điều 
khiển phức tạp nhất.

Người thao tác hoàn toàn độc lập 
trong việc thay đổi nội dung điều khiển 
thông qua thay đổi chương trình.

Chỉ có thể thay đổi bằng 
cách đấu nối dây.

Độ tin cậy cao nhờ thiết bị 
bán dẫn được tích hợp bên 
trong thiết bị.  

Dù không hạn chế trong sử dụng 
hàng ngày nhưng vẫn bị giới hạn về 
kết nối và tuổi thọ thiết bị.

Phải kiểm tra định kỳ và thay 
thế các linh kiện tuổi thọ 
ngắn.

Thường lớn  

Tham khảo

Khả năng mở rộng
thiết bị
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MEMO



 Lập trình với máy vi tính !

Thật đơn giản khi thao tác PLC trên máy vi tính...
Thông qua phần mềm GX Works2, việc biên soạn và lập trình PLC trở nên đơn 
giản nhờ vào các hình vẽ minh họa. Khi bạn đã sử dụng thành thạo những thao 
tác cơ bản, thì việc thao tác với PLC trở nên vô cùng nhẹ nhàng vì chỉ cần lặp lại 
những thao tác cũ. 
Chương trình được tích hợp rất nhiều tính năng dễ sử dụng, dưới đây, chúng ta 
hãy bắt đầu từ những thao tác đơn giản nhất.

Nhẹ nhàng khởi động và điều chỉnh thiết kế mới…
Chương trình được trang bị chức năng hiệu chỉnh lỗi.
Đồng thời, trạng thái vận hành của PLC và chương trình có thể được theo dõi 
thông qua màn hình máy tính, giúp bạn nhanh chóng phát hiện và điều chỉnh các 
phần thiết bị hoạt động không chuẩn xác.

Chương trình dễ sử dụng.
GX Works2 được tích hợp "Chức năng nhập ghi chú" nhằm hỗ trợ việc đọc các 
chương trình tuần tự.
Đồng thời, chức năng nhập ghi chú cũng giúp nâng cao hiệu quả lập trình và 
hiệu chỉnh lỗi của các chương trình tuần tự.

VẬN HÀNH GX Works2
Chương 3
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3.1 Kiến thức cơ bản về GX Works2
3.1.1 Cấu trúc màn hình của GX Works2

1) Thanh tiêu đề
Thanh tiêu để sẽ hiển thị tên của thiết kế đang mở và các biểu tượng vận hành.

1) Thanh tiêu đề

4) Thanh trạng thái

Thay đổi kích cỡ hoặc đóng cửa sổ GX Works2

Hiển thị tên dự án Thu cực tiểu GX Works2 Đóng GX Works2

Phóng lớn cực đại và thu nhỏ màn hình GX Works2

2) Thanh trình đơn

6) Màn hình biên soạn

3) Thanh công cụ

5)Cửa sổ điều hướng
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2) Thanh trình đơn

Khi bạn chọn một danh mục trên thanh trình đơn, thanh trình đơn sẽ trải xuống.

3) Thanh công cụ

* : Các nội dung của thanh công cụ có thể được di chuyển, bổ sung hoặc tách rời ra khỏi 
thanh công cụ. Do đó, nội dung hiển thị và bố trị trên thanh công cụ sẽ khác nhau tùy 
vào môi trường làm việc..

Các chức năng có tần suất sử dụng lớn được bố trí ngay trên thanh công cụ. Nhờ đó bạn 
có thể thao tác trực tiếp mà không cần lựa chọn từ các thanh trình đơn.

Khi bạn rê chuột 
đến vị trí tương 
ứng, nội dung của 
chức năng đó sẽ  
hiển thị.

4) Thanh trạng thái
Thanh trạng thái thể hiện tình trạng thao tác và cài đặt.

Hiển thị chế độ đang nhập

Trạng thái Scroll Lock 

Loại
CPU

Trạng thái
Caps Lock

   Nơi CPU được 
         kết nối

Trạng thái
Num Lock
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6) Màn hình biên soạn

5) Cửa sổ điều hướng

Chương trình tuần tự được hiển 
thị khi bạn nhấp chuột chọn theo 
trình tự [POU] → [Program]→ 
[MAIN]

Khi bạn nhấp chuột vào Mục 
Project, cấu trúc cây thể hiện nội 
dung của Dự án sẽ hiển thị tại 
phần cửa sổ phía trên.

Khi bạn nhấp chuột vào phần này, 
đích kết nối máy tính cá nhân (kết 
nối PLC) sẽ hiển thị lên phần cửa 
sổ bên trên.

Tab chuyển đổi



35

3.1.2 Không gian làm việc và bản thiết kế (Project)

Dự án thiết kế

Chương trình

Ghi chú thiết bị

Thông số

Bộ nhớ thiết bị

Tương ứng với một thư mục trong Windows®.

Chương trình tuần tự

Các ghi chú trên thiết bị

Dữ liệu cài đặt thông số của PLC

Các giá trị thiết bị hiện hành hoặc nhập vào

Tương ứng với một thư mục trong Windows®.
Không gian làm việc

n Không gian làm việc
Không gian làm việc của GX Works2 có thể điều khiển nhiều thiết kế dưới cùng một 
tên gọi. 
Bạn không nên thay đổi cấu hình không gian làm việc bằng Windows® Explorer hoặc 
phần mềm khác.

n Dự án thiết kế
Một dự án thiết kế sẽ bao gồm các mục : “Program” (Chương trình), “Device Comment” 
(Ghi chú thiết bị), “Parameter” (Thông số) và “Device Memory” (Bộ nhớ thiết bị)
Trong GX Work2, tập hợp một chuỗi dữ liệu được gọi là “Project” và được lưu trữ    
trong thư mục có tên là Workspace (Không gian làm việc).

Khi được lưu trữ trong định dạng không gian làm việc
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3.2 Khởi động GX Works2 và tạo một thiết kế mới
3.2.1 Khởi động GX Works2

1) Chọn Start trong Windows®, 

	 và chọn ứng dụng như sau:

2) GX Works2 khởi động.

[GX Works2]

[MELSOFT Application]

[Programs]
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1) Chọn  từ thanh công cụ hoặc chọn 
[Project] → [New] ( Ctrl + N )từ trình 
đơn.

3.2.2 Tạo thiết kế mới

2) Nhấp vào nút [▼] của [Series].

3) Chọn "FXCPU".

4) Nhấp vào nút [▼] của [Type].

5) Chọn "FX3G/3GC".

(Chú ý) Chọn tên dòng máy mà bạn sử dụng.

1) Nhấp vào

2) Nhấp vào

4) Nhấp vào

3) Nhấp và chọn

5) Nhấp và chọn

1) Nhấp vào
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6) Chọn OK .

(Chú ý) Trong mục "Project Type", chọn 
"Simple Project".

	       Bạn kiểm tra xem mục "Use Label" 
           có bị đánh dấu hay không. Mục này  
           ta phải để trống.
	     Trong mục "Language" (Ngôn ngữ 
           lập trình), chọn "Ladder"

7) Màn hình thiết kế mới sẽ hiển thị để 
nhập dữ liệu thiết kế.

6) Nhấp vào

7) Màn hình thiết kế mới
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3.3 Tạo chương trình
3.3.1 Tạo chương trình bằng phím chức năng

[Chương trình được tạo]

X002
Y000

Y000

X000

X003
Y001

Các phím chức năng chính và mô hình mạng tương ứng được hiển thị trên thanh công cụ. 

LƯU Ý

F5 F6 F7

F8

F9

F5

Shift Shift

F6

Shift

F9

Ctrl

F10

F9

Ctrl
+

++++

LƯU Ý
Trong tài liệu hướng dẫn này, rơle ngõ 
vào và ngõ ra được hiển thị bằng các 
số có 3 chữ số như "X000" và "Y000." 
Tuy nhiên, khi nhập từ máy tính, các 
số 0 cạnh các chữ X0, Y0 có thể lược 
bỏ.

Các phím thao tác chính

  • " Tiếp điểm NO " và "Cuộn (    　　)(　) , (    　　)[　] " có thể được nhập vào trực tiếp mà không 
cần sử dụng các biểu tượng trên bàn phím.
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6) Ngõ vào bậc thang  được hiển thị.
7) Nhấn F7 (    　　)(　) .

    Nhập "Y0".

8) Xác nhận bằng nhấn  Enter  hoặc OK.

9)   Ngõ vào bậc thang (     　　)(Y0)  được hiển  
      thị.

10) Nhấn Shift  + F5  . 
  Nhập "Y0".

11) Xác nhận bằng nhấn  Enter  hoặc OK.

3) Ngõ vào bậc thang 
X2

 được hiển thị.
4) Nhấn F6 .

    Nhập "X0".

5) Xác nhận bằng nhấn  Enter  hoặc OK.

1) Nhấn F5   
Nhập "X2".

Hủy bằng ESC  hoặc [Exit].

2) Xác nhận bằng nhấn  Enter  hoặc OK.

1) Nhập “X2”

4) Nhập  “X0”

7) Nhập “Y0”

10) Nhập “Y0”

3) Phần tử lệnh bậc thang hiển thị.

6) Phần tử lệnh bậc thang hiển thị.

9) Phần tử lệnh bậc thang hiển thị.

2) Nhấn phím  Enter  

5) Nhấn phím  Enter  

8) Nhấn phím  Enter  

11) Nhấn phím  Enter  
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12) Ngõ vào bậc thang Y0  được hiển 
thị.

13) Di chuyển con trỏ đến chỗ bắt đầu 
dòng tiếp theo

14) Nhấn F5 . 
Nhập "X3".

15) Xác nhận bằng nhấn  Enter  hoặc OK.

16) Ngõ vào bậc thang X3  được hiển thị.

17) Nhấn  F7 (    　　)(　) . 
Nhập "Y1".

18) Xác nhận bằng nhấn  Enter  hoặc OK.

19) Ngõ vào bậc thang  được hiển 
thị.

F4 (Thiết lập)

Vùng bóng xám biến mất và chương trình 
được biên soạn.
Nếu có lỗi xảy ra, con trỏ sẽ di chuyển đến 
phần xuất hiện lỗi. Khi đó, hãy điều chỉnh 
chương trình.

20) Thao tác Compile [Quan trọng].

	 Thực hiện lệnh "Compile" (Biên dịch) 
để kết thúc lệnh bậc thang chưa được 
biên soạn (phần màu xám).	
	
 
Chọn một trong 2 thao tác sau:
・		Nhấn F4 (Thiết lập).
・		Chọn  từ thanh công cụ 
・	Hoặc chọn[Compile] → [Build] từ 

trình đơn.

14) Nhập “X3”

17) Nhập “Y1”

12) Phần tử lệnh bậc thang hiển thị.

16) Phần tử lệnh bậc thang hiển thị.

13) Di chuyển con trỏ

15) Nhấn phím Enter  

18) Nhấn phím Enter  

20) Vùng bóng xám biến mất.

19) Phần tử lệnh bậc thang hiển thị.
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3.3.2 Tạo chương trình bằng nút trên thanh công cụ

[Chương trình được tạo]

Nhấp vào các nút thanh công cụ để nhập các phần tử lệnh bậc thang.

LƯU Ý

X002
Y000

Y000

X000

X003
Y001

LƯU Ý
Trong tài liệu này, rơle ngõ vào (X) và 
rơle ngõ ra (Y) được hiển thị bằng 3 
chữ số như "X000" và "Y000". 
Tuy nhiên, khi sử dụng GX Works2, các 
số 0 cạnh các chữ X0, Y0 có thể lược 
bỏ.

●●Các nút thanh công cụ chính
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6) Ngõ vào bậc thang  được hiển thị.

7) Nhấn nút  trên thanh công cụ. 
Nhập "Y0".

8) Xác nhận bằng nhấn  Enter  hoặc OK.

9) Ngõ vào bậc thang (     　　)(Y0)  được hiển 
thị.

10) Nhấn nút  trên thanh công cụ.
      Nhập "Y0".

11) Xác nhận bằng nhấn  Enter  hoặc OK.

Hủy bằng cách chọn  ESC  hoặc [Exit].

3) Ngõ vào bậc thang 
X2

 được hiển thị.

4) Nhấn nút   trên thanh công cụ. 
Nhập "X0".

5) Xác nhận bằng nhấn  Enter  hoặc OK.

2) Xác nhận bằng nhấn  Enter  hoặc OK.

1) Nhấp chọn  trên thanh công cụ. 
Nhập "X2".

1) Nhập “X2”

4) Nhập “X0”

7) Nhập “Y0”

10) Nhập “Y0”

2) Nhấp chuột

5) Nhấp chuột

8) Nhấp chuột

11) Nhấp chuột

3) Phần tử lệnh bậc thang hiển thị.

6) Phần tử lệnh bậc thang hiển thị.

9) Phần tử lệnh bậc thang hiển thị.
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12) Ngõ vào bậc thang Y0  được hiển thị.
13) Di chuyển con trỏ đến chỗ bắt đầu 

dòng kế tiếp.
14) Nhấp nút   trên thanh công cụ. 

Nhập "X3".

15) Xác nhận bằng nhấn  Enter  hoặc OK.

16) Ngõ vào bậc thang X3  được hiển thị.

17) Nhấp nút   trên thanh công cụ. 
Nhập "Y1".

18) Xác nhận bằng nhấn  Enter  hoặc OK.

19) Ngõ vào bậc thang (     　　)(Y1)  được hiển 
thị.

F4 (Thiết lập)

Vùng bóng xám biến mất và chương trình 
được biên soạn.
Nếu có lỗi xảy ra, con trỏ sẽ di chuyển đến 
phần xuất hiện lỗi. Khi đó, hãy điều chỉnh 
chương trình.

20) Thao tác Compile [Quan trọng].

	 Thực hiện lệnh "Compile" (Biên dịch) 
để kết thúc lệnh bậc thang chưa được 
biên soạn (phần màu xám). 
 
Chọn một trong 2 thao tác sau:	
Nhấn F4  (Thiết lập).

	 Chọn  trên thanh công cụ.

       Hoặc chọn[Compile] → [Build] từ trình 
đơn.

17) Nhập “Y1”

14) Nhập “X3”

18) Nhấp

15) Nhấp

12) Phần tử lệnh bậc thang hiển thị.

16) Phần tử lệnh bậc thang hiển thị.

19) Phần tử lệnh bậc thang hiển thị.

20) Vùng bóng xám biến mất.

13) Di chuyển con trỏ
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3.4 Viết chương trình vào PLC
Viết chương trình tuần tự đã tạo ra vào PLC FX.

3.4.1 Kết nối máy tính với PLC 
Kết nối PLC FX3G (bằng cáp USB)
[Chuẩn bị trên máy tính]
Để kết nối PLC FX3G với máy tính cá nhân qua cáp USB, đầu tiên bạn phải cài đặt USB 
driver cho máy tính cá nhân.
Chúng ta tiến hành cài đặt USB driver theo quy trình được mô tả trong phần “Tài liệu hướng 
dẫn sử dụng GX Works2" (Bản phổ cập).

Cổng PLC 
có sẵn
(USB)

Cáp USB 

USB

GX Works2

Cài đặt Driver cho USB 
<Trường hợp sử dụng Windows®7, Windows® 8>
1. Kết nối máy tính với PLC bằng cáp USD, bật nguồn cho máy PLC.
2. Chọn Control Panel/System and Security/Device Manager, click chuột phải vào 

Unknown Device và chọn "Device Software Update".
3. Khi màn hình "Device Software Update" hiện ra, chọn nút "Search Driver Software 

from Computer" , chọn mục "Easysocket USBDrivers" của Thư mục đã cài đặt GX 
Works2 trong màn hình tiếp theo. Trong trường hợp máy tính cài đặt nhiều sản phẩm 
MELSOFT, hãy tham khảo đích cài đặt của sản phẩm đầu tiên.

* Trường hợp sử dụng FX3U-USB-BD, FX-USB-AW để kết nối với máy tính, cách cài đặt có thể 
thay đổi tùy theo máy tính, bạn có thể tham khảo chi tiết trong "Tài liệu hướng dẫn sử dụng 
GXWork2 (Bản phổ cập). 

Lưu ý
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3.4.2 "Transfer Setup" trong GX Works2 và "Writing Program"

Thiết lập cấu hình cài đặt của GX Works2 để giao tiếp với PLC.

3) Màn hình cài đặt kết nối sẽ hiển thị.

4) Click 2 lần vào biểu tượng  trên màn 
hình.

5) Cài đặt port kết nối với máy tính. 

     * Khi kết nối đến USB trong của FX3G, 

chọn USB

       Sau khi cài đặt, chọn nút OK. 

6) Nhấp [OK] sau khi việc cài đặt hoàn tất..

7) Chọn nút "Connect Test", để kiểm tra kết 
nối  với PLC.

8) Sau khi kiểm tra, nhấp OK để xác nhận nội 
dung cài đặt. 

1) Chọn đích kết nối trong phần cửa sổ điều 
hướng.

2) Nhấp chuột 2 lần vào "Connection1".

3) Màn hình cài đặt đích kết nối sẽ xuất hiện

4) Nhấp 2 lần

6) Nhấp

5) Nhấp

7) Nhấp

8) Nhấp

2) Nhấp 2 lần

1) Nhấp
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9) Cài đặt công tắc "RUN/STOP" của PLC sang 
"STOP".

[Lưu ý: Chức năng RUN/STOP tự động trong phần 
mềm lập trình]

・	Khi viết chương trình khi PLC vẫn đang ở trạng 
thái RUN, sau khi thực hiện xong bước thứ (12) 
Trên màn hình sẽ xuất hiện dòng thông báo “Bạn 
chỉ có thể viết chương trình khi CPU ở trạng thái 
STOP. Bạn có muốn viết chương trình ngay lúc 
này?”.

      Nhấp [Yes (Y)] để tiếp tục.
・	Khi viết xong chương trình, màn hình sẽ hiện ra 

thông báo “CPU đang ở trạng thái STOP. Bạn có 
muốn thực hiện RUN từ xa không?”

・	Nhấp [Yes (Y)] để cài đặt PLC sang trạng thái 
RUN.

11) Nhấp [Param + Program].

12) Nhấp [Execute]. 
(Tham khảo “Lưu ý” ở Mục (9) nói trên).

10) Chọn  từ thanh công cụ hoặc chọn  [Online] 
→[Write to PLC] từ trình đơn.

13) Nhấp [Close] sau khi kết thúc.

9) Cài đặt 
  sang "STOP"

Hộp thoại thể hiện tiến trình viết được hiển thị.

10) Nhấp

12) Nhấp

13) Nhấp

Tiến trình viết

11) Chọn dữ liệu được 
viết
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3.4.3 Chế độ theo dõi vận hành PLC

1) Cài đặt công tắc "RUN/STOP" của PLC 
sang "RUN ".

 Kiểm tra vận hành bằng chế độ theo dõi

2) Thực hiện tất cả các vận hành sau đây:
    Nhấp F3 (Chế độ Monitor).
    Nhấp  trên thanh công cụ.

•	Chọn [Online] → [Monitor] → [Start 
Monitoring(All Windows)] từ trình đơn.

1) Cài đặt 
sang "RUN"

1) Cài đặt [Công tắc X002 "ON"] và [Công tắc X000 "OFF"], và kiểm tra [Ngõ ra Y000 "ON"].

2) Kiểm tra [Ngõ ra Y000  "ON"] trong khi [Công tắc X002 "OFF"].

3) Cài đặt [Công tắc X000 "ON"], và kiểm tra [Ngõ ra Y000 "OFF"].

4) Kiểm tra [Ngõ ra Y001 "ON/OFF"] theo [Công tắc X003  "ON/OFF"].

2) Nhấp
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1)	Hiển thị hộp thoại trạng thái theo dõi 

2) 4)3) 1)

 
 
 
 
 
 
 
 
 
 
 

2)	Giải thích về hiển thị theo dõi lệnh bậc thang

Tham khảo

1)	Thời gian quét 
Hiển thị thời gian tối đa của chương trình 
tuần tự.

2)	Trạng thái PLC 
 Hiển thị trạng thái PLC 
"

▲
" hiển thị khi PLC ở chế độ RUN, và 

" ■" hiển thị khi PLC ở chế độ STOP. 

3)	Trạng thái thực hiện theo dõi. 
Biểu tượng này sáng lên trong chế độ 
theo dõi.

4)	Loại bộ nhớ 
Loại bộ nhớ của PLC được hiển thị.

1. Lệnh tiếp điểm
Tiếp điểm 

Loại
X0 : OFF X0 : ON

Tiếp điểm NO 
X000

Tiếp điểm mở

X000

Tiếp điểm đóng

Tiếp điểm NC
X000

Tiếp điểm đóng

X000

Tiếp điểm mở

2.Lệnh ngõ ra
  Trạng thái điều khiển

Loại
Không thực hiện /
Không điều khiển

Thực hiện / Điều khiển

Lệnh OUT
Y000 Y000

Lệnh SET ...
SET M0 SET M0

Trạng thái ON/OFF của thiết bị thiết lập lại được hiển thị trong suốt chế độ bằng 
lệnh RST.

Trạng thái thiết bị

Loại
Khi thiết bị thiết lập lại  

OFF
Khi thiết bị thiết lập lại  

ON

RST instruction
RST M0 RST M0
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3.5 Biên soạn chương trình
3.5.1 Sửa chương trình

Chuyển đổi giữa "Ovrwrite" và "Insert".
  • Cài đặt sang "Ovrwrte" khi sửa và viết chồng lệnh bậc thang.
  • Lệnh bậc thang mới sẽ được chèn vào khi chế độ "Insert" được mở lên.

Chú ý

Chuyển đổi giữa "Ovrwrte" 
và "Insert" bằng cách

  nhấn nút  Insert
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[1] Thay đổi các cuộn và tiếp điểm OUT (NGÕ RA)

[Chương trình được sửa]

4) Kết quả sửa được hiển thị và khối lệnh bậc 
thanh hiển thị ở màu xám.

1) Nhấp 2 lần vào phần cần sửa.

5) Xác nhận thay đổi bằng việc nhấn F4 (Thiết 
lập)

2) Đổi "Y001" thành"Y002".

3) Xác nhận bằng cách nhấn nút Enter  hoặc 
chọn [OK].

5) F4 (Thiết lập)

X002

Y000

X000

X003
Y001

Y002
Đổi thành

Y000

2) Đổi "Y002"

1) Nhấp 2 lần

4) Kết quả sửa hiển thị

3) Nhấn phím Enter  
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[2] Thêm các dòng

[Chương trình được sửa]

3) Dòng đến vị trí bỏ ra được thêm vào.
4) Định vị con trỏ ở vị trí mà cuộn OUT sẽ 

được thêm vào và nhấp vào    trên 
thanh công cụ.

1) Nhấp vào  ( F10 ) trên thanh công cụ.

X002

Y000

X000

X003
Y002

Thêm các dòng
đứng/ngang và tạo
 cuộn OUT.

Y000

Y003

2) Định vị con trỏ bên phải phía trên của vị trí 
đầu dòng cần thêm vào và rê chuột đến vị 
trí mong muốn, rồi thả chuột

5) Nhập "Y3".

6) Xác nhận bằng nhấn Enter  hoặc [OK].

1) Nhấp

2) Rê chuột

Dòng được thêm

5) Đổi "Y3"

4) Vị trí con trỏ

Định vị con trỏ tại vị trí phía trên nơi sẽ thêm 
dòng. 

6) Nhấn phím Enter  
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8) Xác nhận thay đổi bằng nhấn phím F4  
(Thiết lập) 

7) Như vậy, lệnh bậc thang đã được thêm 
vào và khối lệnh sẽ hiển thị thành màu 
xám.

 8) F4 (Thiết lập)

•   Nhấp F10  trên thanh công cụ một lần nữa 
để hoàn tất.

Thêm dòng bằng các phím
Trong GX Works2, dòng có thể được thêm vào hoặc xóa bỏ bằng cách dùng các phím Ctrl  + , 

, , .

Tham khảo

7) Hoàn tất thêm vào 
bậc thang
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[3] Xóa dòng

Chương trình có dòng được xóa

3)	Phần dòng kẻ tương ứng sẽ được xóa.

4)	Xóa cuộn OUT bằng việc nhấn phím Delete .

1) Nhấp  Alt + F9  trên thanh công cụ.

X002

Y000

X000

X003
Y002

  Xóa lệnh 
  này

Y000

Y003

2) Định vị con trỏ vào vị trí bên phải phía trên 
của dòng đứng cần xóa và rê chuột đến vị 
trí mong muốn, rồi thả chuột.

3) Dòng được xóa 

1) Nhấp

4) Xóa dòng bằng phím Delete

Định vị con trỏ bên phải phía trên của chỗ bắt 
đầu dòng thẳng đứng cần được xóa.

2) Rê chuột
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5) Khối lệnh được xóa hiển thị ở màu xám.

6) Xác nhận thay đổi bằng nhấn phím F4

(Thiết lập).

6) F4 (Thiết lập)

•	Nhấp  trên thanh công cụ một lần nữa 
để hoàn tất..

Xóa dòng bằng các phím
Trong GX Works2, dòng có thể được thêm vào hoặc xóa bỏ bằng cách dùng các phím Ctrl  + , 

, , .

Tham khảo
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3.5.2 Chèn và xóa hàng

[1] Thêm hàng

[Chương trình có bậc thang được chèn vào]

X002

Y000

X000

X003
Y002

Thêm bậc nàyX001

Y000

Y001

1)	Định vị con trỏ ở phía dưới hàng được 
chèn.

   Hàng sẽ được chèn vào vị trí phía trên vị trí 
con trỏ chuột.

Chọn "Insert Row"

2) Nhấp phải 
    chuột

3) Hàng mới được chèn vào

2)	Nhấp chuột phải vào vị trí bất kỳ và click 
chuột. Chọn [Edit] → [Insert Row].

3)	Hàng được chèn vào.                       

4)	Thêm lệnh bậc thang vào hàng được 
chèn. X001

Y001
 

5)	Xác nhận thay đổi bằng nhấn phím Build  
(F4).

4) Thêm lệnh

1) Di chuyển con trỏ đến hàng, 
bên dưới hàng chèn vào
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[2] Xóa hàng

[Chương trình có hàng được xóa]

3) Hàng được xóa.

1) Di chuyển đến hàng cần xóa.

2) Nhấp chuột phải vào vị trí bất kỳ và click 
chuột. Chọn [Edit] → [Delete Row].

Xác nhận bằng nhấn  Build  (F4).

Lưu ý

X002

Y000

X000

X003
Y002

Xóa hàng này

X001

Y000

Y001

1) Di chuyển con trỏ đến 
hàng cần xóa

2)Nhấp chuột 
   phải

3) Hàng được xóa

Chọn "Delete Row"
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3.5.3 Cắt và chép (dán) bậc thang

[1] Cắt

[Chương trình được biên soạn]

3) Chọn  , từ thanh công cụ hoặc chọn 
[Edit]→ [Cut] từ trình đơn ( Ctrl  + X  ) và 
thực hiện cắt.

1) Di chuyển con trỏ đến chỗ bắt đầu của 

lệnh bậc thang cần cắt.

X002

Y000

X000

X001

Y000

Y001
Cắt hàng này

2) Rê đến vị tri mong muốn và thả chuột.

4) Vùng chọn được cắt.

	 Trong trường hợp chỉ cắt một phần bậc 
thang, vùng màu xám sẽ vẫn hiển thị. Sau 
khi sửa bậc thang, xác nhận thay đổi bằng 
việc nhấn F4  (Thiết lập).

2) Rê con trỏ tới vị trí mong muốn 
và bỏ ra tại đó

3) Thực hiện cắt

4) Vùng chọn được cắt

Vùng cắt và chép
1) Di chuyển con trỏ đến 

chỗ bắt đầu của vùng 
cần cắt
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[2] Chép (Dán)

3) Chọn  từ thanh công cụ hoặc chọn 
[Edit]→ [Copy] ( Ctrl + C ) từ trình đơn.

2) Rê con trỏ đến vị trí mong muốn và thả 
chuột.

5) Select  từ thanh công cụ hoặc chọn 
[Edit]→ [Paste] ( Ctrl + V ) từ trình đơn.

 
Trong trường hợp chỉ dán một phần bậc 
thang, vùng màu xám sẽ vẫn hiển thị. Sau 
khi sửa bậc thang, xác nhận thay đổi bằng 
việc nhấn F4 (Thiết lập).

1) Di chuyển con trỏ đến chỗ bắt đầu của bậc 
thang cần chép.

4) Di chuyển con trỏ đến vị trí cần dán.

Dùng phím Insert  
Chế độ "Ovrwrte": Dán bằng cách viết 
chồng dữ liệu ở vị trí con trỏ.
Chế độ "Insert": Dán bằng cách chèn 
dữ liệu ở vị trí con trỏ.

Lưu ý

Y000

X000

X002
Y000

Chép 
hàng này

X002
Y000

Y000

X000 Dán vào 
hàng này

[Bậc thang được dán]

2) Rê con trỏ đến vị trí mong muốn 
và bỏ ra tại đó

3)Thực hiện chép

4) Di chuyển con trỏ đến vị 
trí cần dán

1)Di chuyển con trỏ đến chỗ 
bắt đầu của vùng cần chép

5) Hoàn tất chép/dán
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3.6 Lưu chương trình
3.6.1 Lưu file mới và lưu chồng

 Lưu ý

1) Chọn  từ thanh công cụ hoặc chọn 
[Project]→ [Save] ( Ctrl + S  ) hoặc [Save as] 
từ trình đơn.

(Khi mới được lưu)

Nếu có lệnh bậc thang chưa được biên soạn, nhấn Build  (F4).

(Khi lưu mới)

 Hoàn tất thiết kế   

2) Xác định nơi lưu trữ cho file.

3) Xác định tên file.

4) Xác định tên dự án thiết kế 
	 (tùy chọn)
5) Nhấp  Save  .

6) Nhấp  Yes  trong hộp thoại xác nhận để hoàn 
tất.6) Nhấp

4) Xác định tiêu đề 
(Tùy chọn).

3) Xác định tên file 

2)Xác định đích lưu trữ 
cho file

1) Click

5) Nhấp
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3.6.2 Đọc bản thiết kế

1) Chọn   từ thanh công cụ hoặc chọn
[Project] → [Open]  ( Ctrl + O  ).

Nếu bạn mở một bản thiết kế khác khi đang đọc/mở bản thiết kế hiện tại, bản thiết kế hiện tại sẽ 
đóng lại.
Nếu có bậc thang chưa được biên soạn trong thiết kế hoặc thiết kế chưa được lưu, một thông 
điệp cảnh báo sẽ hiển thị.

Tham khảo

2) Chọn đích lưu trữ của file.

3) Mở file cần đọc

4) Nhấp Open để đọc thiết kế.

	

2) Chọn đích lưu trữ của 
file

3) Chọn thiết kế cần 
đọc

1) Nhấp

4) Nhấp
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3.7 Sửa lỗi chương trình
Để kết nối với PLC và viết chương trình vào PLC, xem phần "3.4 Viết chương trình vào PLC".

3.7.1 Theo dõi lệnh bậc thang
Hiển thị bậc thang và theo dõi tình trạng dẫn điện của các tiếp điểm và tình trạng điều khiển 
của các cuộn dây.
(Xem phần "3.4 Viết chương trình vào PLC") .

2) Tình trạng ON/OFF của lệnh bậc thang và 
giá trị hiện hành của các thiết bị thông tin 
(bộ, định thời gian, bộ đếm và bộ ghi dữ 
liệu) sẽ hiển thị trong cửa sổ theo dõi lệnh 
bậc thang.

1) Chọn    từ thanh công cụ hoặc chọn
	 [Online] → [Monitor] → [Start Monitoring (All 

Windows)] từ trình đơn.

Tham khảo 
 Trong GX Works2, dừng theo dõi bằng chọn   (Dừng theo dõi) trên thanh công cụ hoặc [Online]→ 
[Monitor] → [Stop Monitoring] từ trình đơn.
Lệnh bậc thang có thể được biên soạn ngay cả khi đang theo dõi hoặc đã ngừng theo dõi.
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3.7.2 Theo dõi đăng ký thiết bị
Xác định một thiết bị hoặc một khoảng trên cửa sổ theo dõi bậc thang và đăng ký thiết bị 
tương ứng trên cửa sổ quan sát.

5) Thiết bị lựa chọn được đăng ký vào cửa 
sổ quan sát.

6) Có thể nhập trực tiếp các tên thiết bị như 
“X0”, “M0” và “D0” vào các khoảng trống 
của cột “Device/Label” mà không cần dùng 
chuột để rê và thả.

7) Chọn [Online] → [Monitor] → [Star t 
Monitoring] từ trình đơn.

1) Cài đặt chế độ Monitor theo dõi bậc thang. 
(Xem Mục “3.7.1 Theo dõi lệnh bậc thang” 
ở trên).

4) Khi biểu tượng chuột đổi thành  , rê và 
thả vào cửa sổ quan sát.

2)  • Khi đăng ký một thiết bị, nhấp chuột để 
chọn thiết bị đó.

	 • Khi đăng ký nhiều thiết bị, nhấp và rê 
chuột để chọn thiết bị tương ứng.

3) Hiển thị cửa sổ quan sát bằng 
[View]→[Docking Window]→[Watch 1].

2) Khi đăng ký một 
thiết bị

2) Khi đăng ký một 
nhiều thiết bị

5) Việc đăng ký thiết bị 
hoàn tất

4) Rê và bỏ thiết bị được 
chọn vào cửa sổ quan sát

7) ) Khi [Start Monitoring] được chọn, 
các giá trị hiện hành (Thiết bị bit: 
1 (= ON) hoặc 0 (= OFF), thiết bị 
thông tin: giá trị hiện hành) được 
hiển thị.

Rê chuột trong khoảng này

6) Nhập trực tiếp

3) Cửa sổ quan sát 
hiển thị
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3.7.3 Theo dõi loạt thiết bị
Xác định một thiết bị và theo dõi các thiết bị theo sau nó.

1) Cài đặt thành chế độ theo dõi. (Xem phần 
“3.7.1 Theo dõi lệnh bậc thang”).

3) Nhập thiết bị đầu tiên của các thiết bị được 
quan sát   trong cửa sổ "Device/ Buffer 
Memory Batch" rồi nhấn phím Enter  để bắt 
đầu quan sát.. 

(Lưu ý)
	 Khi xác định bộ định thời gian hoặc bộ 

đếm, nhấp [Reference], rồi chọn “MAIN” 
trong danh sách chương trình.

4) Trạng thái vận hành được hiển thị theo loại 
thiết bị.
• Thiết bị bit (X, Y, M và S): ON = 1 hoặc 

OFF = 0
• Bộ hẹn giờ và bộ đếm: tình trạng ON/
   OFF giá trị cài đặt và giá trị hiện hành 
   của tiếp điểm / cuộn dây.
• Dữ liệu đăng ký: Giá trị hiện hành.

5) Thiết bị bit có thể được MỞ hoặc TẮT 
cưỡng bức hoặc giá trị hiện hành của thiết 
bị thông tin có thể được thay đổi bằng việc 
chọn dữ liệu quan sát được hiển thị tương 
ứng và nhấp vào [Modify Value].

2)Chọn [Online] → [Monitor] → [Device/Buffer 
Memory Batch] từ trình đơn. Hoặc nhấp 
chuột phải vào cửa sổ bậc thang và chọn 
[Device/Buffer Memory Batch].

Lưu ý
3) Nhập thiết bị

5) Chỉnh giá trị
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3.7.4 Kiểm tra thiết bị

[1] Cưỡng bức ON/OFF
Sử dụng màn hình kiểm tra thiết bị để cưỡng bức ON/OFF các thiết bị bit của PLC (M, Y, T, C 
…). Khi một ngõ vào (X) bị cưỡng bức ON hoặc OFF, nếu PLC ở trạng thái RUN, ngõ vào sẽ 
ON hoặc OFF trong 1 chu kỳ quan sát.
Trước khi xác nhận vận hành của dòng Y, phải chuyển PLC về trạng thái STOP.

1)	 Cài đặt sang chế độ quan sát. (Xem phần 
“3.7.1 Theo dõi lệnh bậc thang”).

2)	 Chọn  [Debug] → [Modify Value] từ trình 
đơn. 

      Cưỡng bức ON/OFF (Cửa sổ quan sát bậc thang)
Bất kỳ thiết bị bit nào (tiếp điểm và cuộn) có thể bị cưỡng bức ON/OFF bằng việc nhấp 2 lần vào 
thiết bị trong [Ladder Monitor Window] vừa giữ phím [Shift].

Tham khảo

3) Nhập số của thiết bị sẽ cưỡng bứcON/
OFF.

4)   • [ON]: Cưỡng bức thiết bị ON.
      • [OFF]: Cưỡng bức thiết bị OFF.
    • [Switch ON/OFF]: Chuyển đổi ON/OFF 

mỗi khi trạng thái cưỡng bức thiết bị.

3) Nhập thiết bị

4) Nhấp
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[2] Thay đổi giá trị hiện hành của thiết bị thông tin
Thay đổi giá trị hiện hành của thiết bị thông tin của PLC (T, C, D ...).

1)	 Cài đặt sang chế độ quan sát. (Xem 
phần“3.7.1 Theo dõi lệnh bậc thang”).

2)	 Chọn [Debug] → [Modify Value] từ trình 
đơn.

3) Nhập số của thiết bị được thay đổi.

4) Nhập giá trị mới.

5) Nhấp [Set].

3) Nhập thiết bị

4) Giá trị mới 5) Nhấp
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[3] Cưỡng bức ON/OFF và thay đổi giá trị hiện hành dùng cửa sổ quan sát

Có thể cưỡng bức ON hoặc OFF thiết bị bit (như M và Y) hoặc thay đổi giá trị hiện hành của 
thiết bị thông tin (như T, C và D) từ cửa sổ quan sát.
Khi một ngõ vào (X) bị cưỡng bức ON hoặc OFF, nếu PLC ở trạng thái RUN, ngõ vào sẽ ON 
hoặc OFF trong 1 chu kỳ quan sát.
Khi kiểm tra vận hành của các ngõ ra (Y), bạn phải cài PLC sang trạng thái STOP.

1) Nhập số của thiết bị vào cột “Device/ 
Label” và đăng ký nó vào cửa sổ quan sát.
(Lưu ý) 
Sau khi đăng ký thiết bị,  chọn  [Online] → 

[Watch] →
[Start Watching] từ trình đơn.

2) Nhập giá trị mới vào cột “Current Value” và 
nhấn phím Enter .
  • Các thiết bị bit (như X và Y): Nhập “1”  

cho “ON” hoặc “0” cho “OFF”.
  • Các thiết bị thông tin (như T, C và D) : 

Nhập giá trị số trong vùng có sẵn của 
thiết bị. 

2) Nhập giá trị thay đổi.

1) Đăng ký thiết bị.
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3.7.5 Viết chương trình vào PLC trong khi RUN
Chèn phần chỉnh sửa của bậc thang vào PLC khi PLC đang chạy.
Việc chèn phần chỉnh sửa của bậc thang sẽ tốn ít thời gian do không cần chuyển đổi toàn bộ 
chương trình.

1) Một tiếp điểm sẽ được thêm vào bậc thang

   từ bên trái làm ví dụ. Ở khoảng nhìn bậc 
thang, cài đặt chế độ sang chế độ viết	 .

Không thể viết chương trình vào PLC nếu chương trình trong PLC khác với chương trình trong 
GX Works2.Do đó, bạn phải kiểm tra trước khi viết chương trình hoặc chuyển đổi chương trình 
bằng cách sử dụng [Write to PLC].

Lưu ý

2) Thêm tiếp điểm.
	 Khối lệnh bậc thang được hiển thị màu 

xám.

3) Nhấn [Shift]  và  [F4]  cùng lúc hoặc chọn 
[Compile] → [Online Program Change] từ 
trình đơn.

5) Thông điệp "Thay đổi trực tuyến hoàn tất." 
được hiển thị. Nhấp [OK]. 

Viết trong khi RUN [Shift]+[F4]

4) Nhấp [Yes] để xác nhận thông điệp cảnh 
báo về an toàn PLC liên qua đến những 
thay đổi trực tuyến.

2) Thêm tiếp điểm

4) Nhấp

5) Nhấp



69

3.8 Nhập ghi chú
3.8.1 Các loại ghi chú
Bạn có thể nhập 3 loại ghi chú sau đây.

Loại Mục đích
Số kí tự 

(độ rộng toàn 
phần)

Ghi chú

1) Ghi chú thiết bị
Ghi chú mô tả vai trò và chức 
năng của mỗi thiết bị.

16

Cần thiết cài đặt "Comments Capacity” trong cài 
đặt thông số khi viết vào PLC. Bạn cũng phải cài 
đặt cho Mục "Comment range setting" (Cài đặt 
phạm vi ghi chú).

2) Hướng dẫn
Ghi chú mô tả vai trò và chức 
năng của các khối lệnh bậc 
thang

32
Đây là ghi chú trên GX Works2.
(Nó không được tải vào PLC).

3) Ghi chú
Ghi chú mô tả vai trò và chức 
năng của các lệnh ngõ ra.

16
Đây là ghi chú trên GX Works2.
(Nó không được tải vào PLC).

[Ví dụ ghi chú]

Ghi chú thiết bị toàn bộ và cục bộ trong GX Works2
•	 Ghi chú thiết bị toàn bộ: Loại ghi chú này có thể được viết vào PLC.
•	 Ghi chú thiết bị cục bộ: Khi cài đặt mới các ghi chú thiết bị cục bộ, có thể tạo nhiều ghi chú khác với 

các ghi chú thiết bị toàn bộ. Trong Developer chúng ta có thể sử dụng thông qua tên ghi chú khác 
nhau, và sử dụng được cho QnH, QnU, tuy nhiên trong FX Series, chúng ta không thể viết chương 
trình vào QnH, và QnU. Thông thường, các bạn nên sử dụng “Ghi chú thiết bị toàn bộ”.

Lưu ý

Cách hiển thị ghi chú
Chọn [View] → [Comment] từ trình đơn để làm hiển thị ghi chú.
Làm tương tự như trên để dừng hiển thị các ghi chú.

Lưu ý

Tiếp điểm T5 NO có ở bước 10, 
trong khi tiếp điểm T5 NC có ở 
bước 8 

2) Statement

3) Note

1) Comment
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3.8.2 Tạo ghi chú thiết bị

[1] Cách nhập ghi chú từ danh sách Dự án thiết kế.
1) Nhấp chuột vào [Global Device comment] 

trong danh sách Dự án thiết kế.

2)Nhập số đầu tiên của thiết bị sẽ lập ghi chú 
vào phần "Device Name" và nhấn phím 
Enter .

3) Nhập các ghi chú vào cột "Comment" .

•	Khi nhập ghi chú cho thiết bị khác, nhập 
số thiết bị một lần nữa trong Bước 2

1) Nhấp  từ thanh công cụ và nhấp 2 
lầnvào phần tử bậc thang được ghi chú.

2) INhập ghi chú vào cửa sổ "Enter symbol"và 
nhấp [OK].Nhấp   trên thanh công cụ 
lần nữa để hoàn tất.

[2] Cách nhập ghi chú thiết bị trong lệnh bậc thang

1) Nhấp 2 lần

1) Nhấp 2 lần

2) Nhập ghi chú

2) Nhập số của thiết bị

3) Nhập ghi chú
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Cài đặt cho việc viết ghi chú thiết bị vào PLC
Để viết ghi chú thiết bị vào PLC, phải cài đặt "Parameter Setting" và "Comment Range Setting"

1) Cài đặt thông số

Lưu ý

1)	Nhấp 2 lần [Parameter] → [PLC 
parameter] trong danh sách thiết 
kế.

2)	Cài đặt "Number of blocks" trong 
cài đặt "Comments capacity" .

	 Một khối tương đương với 50 ghi 
chú, chiếm 500 bước lặp của bộ 
nhớ chương trình.

Cách nhập ghi chú khi tạo lệnh bậc thang
Tham khảo

Khi nhập phần tử lệnh bậc thang, nhấp biểu 
tượng hiển thị bên trái để thay đổi phương 
pháp nhập.

2) Cách cài đặt dung lượng ghi chú

Dung lượng của chương 
trình giảm khi có thêm khối 
ghi chúđược thêm vào.

 2) Đánh dấu  3) Nhấp

4) Cài đặt 
khoảng ghi 
chú

2) Cài đặt vùng ghi chú

1)	Chọn [Online] →[Write to PLC] từ 
trình đơn.

2)	Đánh dấu "Global device 
comment"

3)	Nhấp [details]. 

4)	Cài đặt loại thiết bị và khoảng 
trong hộp thoại Device Comment 
Detail Setting.

1) Nhấp 2 lần
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3.8.3 Tiến hành tạo các hướng dẫn lệnh

1) Nhấp   từ thanh công cụ và nhấp 2 lần 
vào vị trí bất kỳ trên khối bậc thang mà bạn 
sẽ nhập hướng dẫn..

2) Nhập hướng dẫn vào cửa sổ "Enter line 
statement" và nhấp [OK].

•	Nhấp  rên thanh công cụ lần nữa để 
hoàn tất.

3.8.4 Tiến hành tạo ghi chú

1) Nhấp   từ thanh công cụ và nhấp 2 lần 
vào biểu tượng chỉ dẫn ngõ ra mà ghi chú 
sẽ được viết vào.

2) Nhập ghi chú vào cửa sổ "Enter Note” và 
nhấp [OK].

•	Nhấp  trên thanh công cụ lần nữa để 
hoàn tất. 

1) Nhấp 2 lần

1) Nhấp 2 lần

2) Nhập ghi chú

2) Nhập hướng dẫn



LỆNH TUẦN TỰ

Đến chương này…
Chúng ta đã biết PLC là một tập hợp nhiều rơle, bộ hẹn giờ và bộ đếm. Đồng 
thời, các chương trình tuần tự bên trong có thể được nối dây bằng cách vận 
hành các phím trên bảng lập trình. Khi thực hiện công việc nối dây này, phải tuân 
theo các yêu cầu về nguyên tắc kết nối tiếp điểm và cuộn dây, loại cuộn dây. 
Các nguyên tắc này được gọi là các lệnh.
Các lệnh được lập trình theo hình thức "từ lệnh + số của thiết bị" hoặc bằng các 
từ lệnh riêng lẻ.
Trong chương này, chúng tôi sẽ giới thiệu các lệnh cơ bản cho việc lập trình một 
PLC.
Các bạn hãy ghi nhớ công dụng của từng lệnh.

LỆNH TUẦN TỰ
Chương 4
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4.1 Ghi nhớ Lệnh PLC
4.1.1 Các lệnh và chương trình
Có 2 loại thiết bị ngoại vi (thiết bị lập trình) được sử dụng chủ yếu để nhập các 
chương trình tuần tự: thiết bị sử dụng để vẽ mạch tuần tự trên màn hình và thiết 
bị sử dụng bằng cách lập trình thông qua từ lệnh (đây là các thiết bị được sử 
dụng đtạo chương trình danh sách lệnh). Các thiết bị này chỉ khác nhau về 
phương pháp nhập, về hình thức lập trình đều tương tự như nhau. 

Bảng sau đây tóm tắt các lệnh chứa bởi PLC, ý nghĩa của mỗi lệnh và cách lệnh 
bậc thang được lập trong một chương trình tuần tự.

      và       dùng trong các 
lệnh bậc thang chỉ các tiếp 
điểm. Tiếp điểm có 2 trạng 
thái, dẫn điện và không dẫn 
điện, phụ thuộc trạng thái 
ON/OFF của các rơle ngõ 
vào hoặc ngõ ra, các rơle 
phụ trợ, bộ hẹn giờ và bộ 
đếm
          và      SET         thể 
hiện trạng thái dẫn động 
cuộn dây .

Thiết bị nhập bằng Sơ đồ tuần tự 
        (Bảng lập trình cầm tay)

Thiết bị nhập bằng Chương trình bậc thang
      (Phần mềm lập trình trên máy tính)

LD

LDI

AND

ANI

OR

ORI

ANB

ORB

OUT

SET

RST

NOP

END

Ký hiệu, Tên

Tải

Nghịch tải

AND

Nghịch AND

OR

Nghịch OR

Khối AND 

Khối OR

Ra

Cài đặt

Thiết lập lại

Không vận hành

END

Lệnh kết nối
   bus, tiếp điểm

N.O. 

Lệnh kết nối
   bus, tiếp điểm

N.C. 

Kết nối nối tiếp,
 tiếp điểm N.O. 

Kết nối nối tiếp,
 tiếp điểm N.C. 

Nối song song,
 tiếp điểm N.O. 

Nối song song,
 tiếp điểm N.C. 

Kết nối nối tiếp
 giữa các khối

Nối song song
 giữa các khối

Lệnh điều
khiển cuộn

Vận hành chốt,
lệnh cuộn dây

 Hủy vận hành chốt,
lệnh cuộn dây

Không vận hành

Kết thúc 
chương trình

Hết chương trình                          Trở về bước 0

Để xóa chương trình hoặc khoảng trắng

Chức năng Biểu diễn bậc thang

SET YMS

RST YMSTCD
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0
1
2
3
4
5
6
9

LD
OR
ANI
OUT
LD
ANI
OUT
END

X001
Y000
X003
Y000
Y000
X006

T1  K30

Danh sách lệnh (Chương trình danh sách lệnh) Sơ đồ mạch (Sơ đồ bậc thang)

  Số 
bước

Lệnh

Mã lệnh Thiết bị (số)
(toán hạng)

Lậ
p 

lạ
i v

ận
 h

àn
h

4.1.2 Cấu tạo chương trình

X001
Y000

Y000

X003
0

4

END

X006
T1

K30

9

Y000

Tuần tự bên trong cho điều khiển tuần tự được tạo như chương trình tuần tự với định dạng 
của sơ đồ mạch (sơ đồ bậc thang) và danh sách lệnh.

Mỗi lệnh bao gồm “Mã lệnh + Số thiết bị” . Tuy nhiên, có một số lệnh không có thiết bị.
Ngoài ra, trong vài trường hợp, mã lệnh chỉ để tham chiếu như lệnh.

Một chương trình bao gồm nhiều mã lệnh và số thiết bị (toán hạng).
Các lệnh này được đánh số lần lượt. Số này được gọi là Số bước.
(Các số bước được điều khiển một cách tự động).

Các bước lớn nhất có thể được lập trình tùy thuộc và “Dung lượng bộ nhớ Chương trình” mà PLC sử dụng.
Chẳng hạn, bộ nhớ chương trình thay đổi tùy theo máy, như trong PLC FX1S dung lượng bộ nhớ là "2000" bước, 
FX1N va FX2N dung lượng bộ nhớ là 8000 bước, và trong FX3U dung lượng là "64000" bước.

PLC thực hiện lặp lại lệnh từ bước 0 đến lệnh END. Vận hành này được xem như là vận hành chu trình và 
thời gian yêu cầu để thực hiện một chu trình này được xem là chu kỳ vận hành (thời gian quan sát).
Chu kỳ vận hành sẽ thay đổi theo nội dung của chương trình và thứ tự vận hành thực tế,
khoảng từ vài ms đến vài chục ms.

Chương trình PLC được tạo bởi định dạng sơ đồ mạch (sơ đồ bậc thang) cũng được lưu trong bộ nhớ chương
trình của PLC với định dạng danh sách lệnh (chương trình danh sách lệnh).
Sự chuyển đổi giữa danh sách lệnh (chương trình danh sách lệnh) và sơ đồ mạch (sơ đồ bậc thang) có thể
được thực hiện bằng việc sử dụng phần mềm lập trình trong máy tính cá nhân.



76

OUT
END

Chương trình danh sách lệnh

Chương trình mạch

Ngõ ra Y000 ON khi ngõ vào X000 ON.
Ngõ ra Y003 ON khi ngõ vào X003 OFF.

Lệnh LD (Load) dùng cho tiếp điểm N.O. 
đầu tiên sử dụng trên bus và lệnh LDI 
(Load inverse)  dùng cho tiếp điểm N.C. 
Các lệnh tiếp điểm như  LD và LDI được 
dùng cho các thiết bị như các rơle ngõ vào 
X, rơle ngõ ra Y, bộ định thời gian T, bộ 
đếm C và các rơle phụ M.
Các lệnh điều khiển cuộn như OUT được
dùng cho các thiết bị khác với các rơle 
ngõ vào X.

Bằng chương trình bên trên...
Ngõ vào X000

Ngõ ra  Y000

Ngõ ra  Y003

0
Bước Lệnh

LD X000
OUT Y000
LDI X000
OUT Y003
END

1
2
3
4

LD
LDI

Lệnh kết nối bus
cho tiếp điểm N.O

Load

Lệnh kết nối bus
cho tiếp điểm N.C

Load inverse

Lệnh điều khiển cuộn
Out

Lệnh dùng để kết 
thúc chương trình

End

Số bước

Số bước chỉ thứ tự và kích cỡ của 
chương trình. Nếu bạn lập trình các 
lệnh theo thứ tự của chương trình 
danh sách lệnh thì PLC sẽ tự động 
đặt số bước.

4.1.3 Tiếp điểm N.O., tiếp điểm N.C., lệnh OUR, lệnh END 

X000

Đường chặn được gọi là “bus”.

0

X000
2

4

Y000

Y003

END

Lập trình bằng danh sách lệnh

ONOFF OFF

ONOFF OFF

ON OFF ON

Tham khảo
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Chương trình danh sách lệnh

Chương trình mạch

Ngõ ra Y000 ON khi ngõ vào X000 ON, X001 ON 
và X002 OFF.
Ngõ ra Y003 ON khi ngõ vào X000 ON, X001 
ON, X002 OFF và X003 ON.

Y000 và Y003 vận hành khi tất cả
tiếp điểm được nối nối tiếp điều
khiển AND và ANI đang dẫn
điện.

Lệnh AND (AND) được dùng cho tiếp điểm
N.O. và lệnh ANI (AND Inverse) được dùng
cho tiếp điểm N.C. được kết nối nối tiếp
theo sau các lệnh LD và LDI
.

Ngõ vào  X000

Trong chương trình trên...

Ngõ vào  X002

Ngõ vào  X001

Ngõ vào  X003

Ngõ ra   Y000

Ngõ ra  Y003

0
Bước Lệnh

LD X000
AND X001
ANI X002
OUT Y000

X003AND
Y003OUT

END

1
2
3
4
5
6

AND
ANI

Lệnh kết nối nối tiếp 
cho tiếp điểm N.O.

AND

Lệnh kết nối nối tiếp 
cho tiếp điểm N.C.

AND inverse

Lập trình bằng danh sách lệnh 

X000
0

6 END

X001
Y000

Y003

X002

X003

ON

ON

ON

ONOFF

ON

ON

ON

4.1.4  Kết nối nối tiếp

Tham khảo
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OR
ORI

Chương trình Danh sách lệnh

Lệnh OR (OR) dùng cho tiếp điểm N.O. và lệnh 
ORI (OR Inverse) dùng cho tiếp điểm N.C. 
được nối song song theo sau các lệnh LD và 
LDI.
Ngõ ra Y000 trong chương trình trên vận hành 
khi một trong các tiếp điểm được nối song song 
điều khiển OR và ORI đang dẫn điện.

Trong chương trình trên...

0
Bước       Lệnh

LD X000
OR X001
ORI X002
OUT Y000
END

1
2
3
4

Lệnh nối song song 
cho tiếp điểm N.O.

OR

Lệnh nối song song 
cho tiếp điểm N.C.

OR inverse

Chương trình mạch

Lập trình bằng danh sách lệnh 

4.1.5  Kết nối song song

X000
0

2

4 END

Y000

X001

X002

ON

ON

ON

ON OFF

ON

Ngõ vào X000

Ngõ vào X002

Ngõ vào X001

Ngõ ra Y000

Tham khảo
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Chương trình danh sách lệnh

Chương trình mạch
Chương trình ví dụ 1

Chương trình ví dụ 1

Chương trình ví dụ 2

Khi ngõ vào X000 hoặc X001 và X002 
hoặc X003 mở đồng thời, Y000 mở. 

Khi các ngõ vào X000 và X001 mở 
đồng thời hoặc X002 và X003 mở đồng 
thời, ngõ ra Y000 mở. 

Tham khảo phụ lục để biết chi tiết về lệnh 
ANB và lệnh ORB.

Trong chương trình trên... Trong chương trình trên...

Ngõ vào X003

Ngõ vào X002

Ngõ vào X001

Ngõ vào X000

Ngõ ra Y000

Ngõ vào X003

Ngõ vào X002

Ngõ vào X001

Ngõ vào X000

Ngõ ra Y000

0
Bước      Lệnh

LD X000
OR X001
LD X002
OR X003

Y000
ANB

1
2
3
4

OUT
END

5
6

4.1.6 Kết nối nối tiếp và song song

Lập trình bằng danh sách lệnh

X000
0

END

Y000
X002

X001 X003

X000
0

END

Y000
X001

X002 X003

ON

ON

ON

ON

ONON

ON

ON

ON

ON

ONON

Chương trình danh sách lệnh

Chương trình ví dụ 2

0
Bước     Lệnh

LD X000
AND X001
LD X002
AND X003

Y000
ORB

1
2
3
4

OUT
END

5
6

Tham khảo
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SET
RST

Chương trình mạch

Ngõ ra Y000 ON khi ngõ vào X001 
ON.
Trạng thái vận hành của Y000 được 
giữ ON dù trạng thái ngõ vào X001 
thay đổi từ ON sang OFF.
Ngõ ra Y000 OFF khi ngõ vào X003 
ON.

Tương tự như lệnh OUT, các lệnh này điều 
khiển các cuộn.
Với lệnh OUT, các cuộn được lập trình bằng 
lệnh OUT vẫn OFF khi tiếp điểm điều khiển 
cuộn thay đổi trạng thái từ ON sang OFF. 
Tuy nhiên, khi lệnh SET (Set) được sử dụng, 
trạng thái vận hành của cuộn được giữ ON 
dù trạng của tiếp điểm thay đổi từ ON sang 
OFF.
Lệnh RST (Reset) được sử dụng để thay đổi 
trạng thái của cuộn được điều khiển bằng 
lệnh SET (Set) từ ON sang OFF. 

Trong chương trình trên...

Chương trình Danh sách lệnh

0
Bước     Lệnh

LD X001
SET Y000
LD X003
RST Y000
END

1
2
3
4

Các lệnh SET/RST được dùng 
cho các rơle ngõ ra Y và các rơle 
phụ M.
Lệnh RST cũng được dùng cho 
các bộ đếm và bộ hẹn giờ có nhớ.

Lệnh ngõ ra giữ vận 
hành.

Set

Lệnh hủy giữ vận 
hành.

Reset

4.1.7. Lệnh SET, lệnh RST

X001
0

X003
2

4 END

Y000RST

Y000SET

Lập trình bằng Danh sách lệnh 

ON

ON

ON

Phương pháp nhập

Space

Space

Ngõ vào X001

Ngõ vào X003

Ngõ ra Y000

Tham khảo
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4.1.8 Về Các Mạch Khóa
Vận hành ngõ ra có thể được giữ hoặc hủy thông 
qua lập trình tuần tự tự giữ..

0
1
2
3
4

Bước 
LD
OR
ANI
OUT
END

X001
Y003
X003
Y003

   Lệnh
0
1
2
3
4

Bước
LD
SET
LD
RST
END

X001
Y003
X003
Y003

   Lệnh

Y003 ON khi X001 ON và X003 
OFF.

Y003 tiếp tục vận hành ngay cả 
khi X001 OFF. (Đây là “vận hành 
tự giữ"). Tuy nhiên, Y003 chuyển 
thành OFF thì X003 chuyển thành 
ON.

Khi lệnh SET được sử dụng, ngõ ra sẽ vẫn ON cả khi tiếp điểm điều khiển cuộn OFF.
Ngoài ra, lệnh SET có thể được dùng nhiều lần cho cùng một ngõ ra mà không cần xử lý như cuộn kép. Nó hỗ trợ cho 
việc điều khiển trực tiếp một ngõ ra từ nhiều điểm trong chương trình.

Trong chương trình trên...

Chương trình mạch

[Mạch khóa ngõ ra]  [Mạch SET/RST ngõ ra] 

[Mạch khóa ngõ ra]  [Mạch SET/RST ngõ ra] 

Ngõ vào X001

Ngõ ra Y003

Ngõ vào X003

X001
0 Y003

Y003

X003

ON

ON

ON

X001
Y003

Y003

X003

END

X001

X003

END

Y003SET

Y003RST
vận hành tương tự

0

4

0

4

2

Lập trình bằng danh sách lệnh 

Cả 2 mạch thực hiện cùng một vận hành
Tham khảo

Tham khảo
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4.2 Về Các Mạch Bộ hẹn giờ

0
1
2

Timers Tham khảo

Chương trình hẹn giờ

Có rất nhiều loại thiết bị hẹn giờ, tuy nhiên trong 
phần này chúng tôi chỉ mô tả cách lập trình một 
thiết bị hẹn giờ số gắn bên trong một Micro PLC.

Bước   
LD
OUT
OUT

X000
Y000
T0 K100

   Lệnh
5
6
7

Bước
LD
OUT
END

T0
Y003

Lệnh

Tiếp điểm bộ hẹn giờ vận hành sau khi 
khoảng trì hoãn đặt trước trôi qua sau khi 
cuộn dẫn điện (bộ hẹn giờ trì hoãn ON).  
Thời gian đặt trước này gọi là "giá trị cài 
đặt" và được ký hiệu là K. K có thể được 
cài đặt trong khoảng 1 ~  32,767. 
Ví dụ, K100 nghĩa là bộ hẹn giờ 10s*1.
 
Khi X000 OFF trong khi bộ hẹn giờ đang 
vận hành, giá trị hiện tại của bộ hẹn giờ trở 
về "0" và tiếp điểm bộ hẹn giờ cũng OFF.
Phương  pháp nhập

*1 : When a 100 ms (0.1 second) timer is used

Trong chương trình trên...
Ngõ vào X000

Ngõ ra T0 (N.O. contact)

Ngõ ra  Y000, T0 (coil)

Ngõ ra Y003 (coil)

X000
0

5

Y000

T0
(10 secs)

Y003

END7

K100

T0

ON

ON

ON

ON

10 secs

SECONDS

10

30

4020

50

600

STAR DELTA TIMER

Lập trình bằng danh sách lệnh

Chương trình mạch

Space

Tham khảo
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4.3 Về Các Mạch Bộ Đếm

Counters

Chương trình bộ đếm

Bộ đếm có rất nhiều loại. Tuy nhiên ở đây 
chúng tôi chỉ xin mô tả cách lập trình một bộ 
đếm thông dụng được gắn bên trong một 
Micro PLC.

0
1
3
4

LD
RST
LD
OUT

X001
C0

C0
X003

7
8

LD
OUT

9

C0
Y003

Các bộ đếm đếm số lần một tiếp điểm 
(X003) thay đổi trạng thái từ OFF sang ON.
Tiếp điểm này (X003) được gọi là "ngõ vào 
đếm" và giá trị được đếm bởi bộ đếm được 
gọi là "giá trị hiện tại". 
Bộ đếm vận hành khi giá trị hiện tại đạt tới 
số xác định (giá trị cài đặt). 
Giá trị cài đặt có thể được cài đặt một giá trị 
trong khoảng 1 ~ 32,767. 

Sau khi bộ đếm đã đếm lên, giá trị hiện tại 
của bộ đếm không thay đổi và tiếp điểm ngõ 
ra ở trạng thái vận hành.
Khi ngõ vào reset X001 ON, giá trị hiện tại 
của bộ đếm trở về "0"và tiếp điểm của bộ 
đếm cũng OFF.
Phương pháp nhập

Ngõ ra Y003

Giá trị hiện tại 
của bộ đếm C0

Ngõ vào X003 (đếm)

Input X001 
(reset)

ON

0
1

2
3

4
5

6
7

8
9 10

Tham khảo

Bước Lệnh Bước Lệnh

Lập trình bằng danh sách lệnh 

TIME

Trong chương trình trên...

X001
0

7

C0
K10

Y003

END9

C0RST

X003

C0

3

Reset input

Count input

K10
END

Space

Tham khảo
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Một chương trình như trên được lập sử dụng 16 bước chương trình, (1) đến 
(16). Dưới đây là chương trình viết theo Danh sách lệnh.

4.4 Thứ Tự Của Chương Trình
Thứ tự chương trình
Các sơ đồ mạch được lập trình từ trái sang phải và từ trên xuống dưới.

0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

LD
Bước    Lệnh

OUT
LD
OR
AND
OUT
OUT
LD
AND
LD
AND
ORB
OUT
OUT
OUT
END

X000
Y000
X001
X002
X003
Y001
Y002
X004
X005
X006
X007

Y003
Y004
Y005

(1)

(3)

(4)

(5)

(2)

(6)

(7)

(13)

(14)

(15)

(16)

X000

X001

Y000

Y001

X002

X003

Y002

X004 X005
Y003

X006 X007

Y005

END

Y004

0
Bước

2

7

15

(8) (9)

(10) (11) (12)

Lập trình bằng chương trình danh sách lệnh
Tham khảo



Bắt đầu từ các lập trình đơn giản

Từ lý thuyết đến thực hành…
Trong chương này, thông qua các ví dụ đơn giản, bạn sẽ được học tổng quát về 
cách sử dụng và vận hành chương trình như cách lập trình và sử dụng chế độ 
quan sát. 

Bài tập chương trình
Chương 5
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Điều khiển thang cuốn   
Y003

Công tắc dò 1 X003

Đèn chiếu sáng Y000

Công tắc dò 0 X001

5.1 Ví Dụ Tham khảo 1 
      (Điều Khiển Thang Cuốn)

  Các bố trí I/O
Ngõ vào   Công tắc dò 0  X001
  Công tắc dò 1  X003

Ngõ ra Đèn chiếu sáng Y000
  Ngõ ra điều khiển thang  Y003

  Vận hành
(1)Hãy giả sử rằng thang cuốn không di chuyển cho đến khi có người đến gần 

thang cuốn.
(2)Khi có người lại gần thang cuốn và mở công tắc dò 0, đèn sáng lên và thang 

cuốn bắt đầu di chuyển (chuyển động của thang chỉ đi lên).
(3)Thang cuốn đưa người đi lên, khi người đi ra khỏi thang, công tắc dò 1 ON, 

đèn sáng lên và thang cuốn trở về trạng thái không vận hành.
    Trong ví dụ này, hãy xem cả 2 công tắc dò 0 và 1 như những công tắc không 

giữ.
    Đồng thời, người di chuyển không sử dụng thang cuốn liên tục. 

Chúng ta hãy xem xét một chương trình PLC cho thang cuốn dưới đây.
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Điều khiển thang cuốn   
Y003

Công tắc dò 1 X003

Đèn chiếu sáng Y000

Công tắc dò 0 X001

5.1 Ví Dụ Tham khảo 1 
      (Điều Khiển Thang Cuốn)

  Các bố trí I/O
Ngõ vào   Công tắc dò 0  X001
  Công tắc dò 1  X003

Ngõ ra Đèn chiếu sáng Y000
  Ngõ ra điều khiển thang  Y003

  Vận hành
(1)Hãy giả sử rằng thang cuốn không di chuyển cho đến khi có người đến gần 

thang cuốn.
(2)Khi có người lại gần thang cuốn và mở công tắc dò 0, đèn sáng lên và thang 

cuốn bắt đầu di chuyển (chuyển động của thang chỉ đi lên).
(3)Thang cuốn đưa người đi lên, khi người đi ra khỏi thang, công tắc dò 1 ON, 

đèn sáng lên và thang cuốn trở về trạng thái không vận hành.
    Trong ví dụ này, hãy xem cả 2 công tắc dò 0 và 1 như những công tắc không 

giữ.
    Đồng thời, người di chuyển không sử dụng thang cuốn liên tục. 

Chúng ta hãy xem xét một chương trình PLC cho thang cuốn dưới đây.

Chương trình được thiết lập như sau
   Chương trình mạch : Ví dụ 1

Chương trình mạch : Ví dụ 2

  Hãy cùng kiểm tra vận hành 
Nhập chương trình trên vào PLC và kiểm tra vận hành chương trình.

Khi ngõ vào X001 được ON, các ngõ ra Y000 và Y003 vận hành. Tiếp theo,khi 
ngõ vào X003 được ON, các ngõ ra Y000 và Y003 chuyển sang trạng thái 
không vận hành.

Công tắc dò 0
      X001

Công tắc dò1
X003 Đèn chiếu sáng ON

Điều khiển thang cuốn

Tự giữ
   Y000

Y000

Y003

END

Công tắc dò  0
      X001

Công tắc dò 1
      X003

Đèn chiếu sáng ON

Điều khiển thang cuốn

Đèn chiếu sáng OFF

Ngừng thang cuốn

END

Y000SET

Y003SET

Y000RST

Y003RST

0

5

0

3

6

Refer to the appendix 2 for a list program.
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5.2 Ví dụ Tham khảo 2 (Điều khiển máy pha trà)

Hãy cùng xem xét một chương trình PLC cho một máy pha trà.

  Bố trí I/O 
Ngõ vào Dò tách trà X000 (ON when cup is present)
 Nút pha trà X001
 Nút kiểm tra lá trà X002
 Công tắc hành trình dưới bình làm đầy nước X003
 Công tắc hành trình trên bình làm đầy nước X004

Ngõ ra Đèn hiển thị thay lá trà Y000
 Ngõ ra pha trà Y001
 Ngõ ra làm đầy nước Y003

  Giải thích vận hành
(1)Khi mạch dò tách X000 ON và nút pha trà X001 được nhấn (X001 ON), ngõ ra 

pha trà Y001 vận hành và nước nóng được rót vào tách. Nước nóng chỉ được 
rót trong thời gian nút được nhấn và dừng rót khi thả nút nhấn.

    Khi chức năng dò tách X000 OFF, nước nóng không được rót dù bạn nhấn nút 
pha trà X001.

(2)Khi nước trong bình hạ thấp, công tắc hành trình dưới X003 ON, ngõ ra làm đầy 
nước Y003 hoạt động.

    Khi ngõ ra làm đầy nước Y003 vận hành và nước được rót vào bình, công tắc 
hành trình trên X004 sẽ ON và ngõ ra làm đầy nước Y003 ngừng hoạt động.

(3)Sau 5 lần nước được làm đầy, đèn chỉ thị thay lá trà sáng lên.
(4)Khi nhấn nút xác nhận, đèn chỉ thị thay lá trà sẽ tắt.

      Thay lá trà

Ngõ ra làm đầy nước

       Công tắc hành trình trên

       Công tắc hành trình dưới

Y003

Y000

Dispense
Check

Kiểm tra lá trà

X002

X003

  Dò tách trà
X000

X004Nút pha trà
X001

Ngõ ra pha trà
Y001

Chương trình được thiết lập như sau
  Chương trình mạch

Kiểm tra vận hành
Nhập chương trình mạch trên vào PLC và kiểm tra vận hành chương trình.

(1)Ngõ ra Y001 vận hành khi cả 2 ngõ vào X000 hoặc X001 ON.
(2)Khi ngõ vào X003 ON, ngõ ra Y003 vận hành và khi ngõ vào X004 ON, ngõ ra 

Y003 không vận hành.
(3)Mỗi lần ngõ ra Y003 vận hành, giá trị của bộ đếm C0 tăng lên 1. Khi C0 đến 

"5", Y000 vận hành.
(4)Khi ngõ vào X002 ON, giá trị của bộ đếm C0 trở về "0" và ngõ ra Y000 trở về 

trạng thái không vận hành.

X000 X001

X003 X004

Y003

X002

Y000

RST C0

C0

Y001

END

C0

Y003
K5

Y003

Tự giữ  

Công tắc 
hành trình dưới

Công tắc hành trình trên

Nút pha trà
Ngõ ra pha trà

Ngõ ra  làm đầy nước

Đếm lần làm đầy nước

Đèn chỉ thị thay lá trà

Reset bộ đếm

Công tắc dò

Ngõ ra làm đầy nước

Nút kiểm tra
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Chương trình được thiết lập như sau
  Chương trình mạch

Kiểm tra vận hành
Nhập chương trình mạch trên vào PLC và kiểm tra vận hành chương trình.

(1)Ngõ ra Y001 vận hành khi cả 2 ngõ vào X000 hoặc X001 ON.
(2)Khi ngõ vào X003 ON, ngõ ra Y003 vận hành và khi ngõ vào X004 ON, ngõ ra 

Y003 không vận hành.
(3)Mỗi lần ngõ ra Y003 vận hành, giá trị của bộ đếm C0 tăng lên 1. Khi C0 đến 

"5", Y000 vận hành.
(4)Khi ngõ vào X002 ON, giá trị của bộ đếm C0 trở về "0" và ngõ ra Y000 trở về 

trạng thái không vận hành.

X000 X001

X003 X004

Y003

X002

Y000

RST C0

C0

Y001

END

C0

Y003
K5

Y003

Tự giữ  

Công tắc 
hành trình dưới

Công tắc hành trình trên

Nút pha trà
Ngõ ra pha trà

Ngõ ra  làm đầy nước

Đếm lần làm đầy nước

Đèn chỉ thị thay lá trà

Reset bộ đếm

Công tắc dò

Ngõ ra làm đầy nước

Nút kiểm tra

Tham khảo Phụ lục 2 về Chương trình danh sách lệnh.
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5.3 Ví Dụ Tham khảo 3 (Điều Khiển Quạt)

Hãy cùng xem xét một chương trình PLC cho quạt..

Vận hành
(1) Khi công tắc [Chuẩn bị] (X001) ON, ta làm [Đèn chỉ thị sẵn sàng] (Y000) ON và tự khóa. 

Khi công tắc [Hủy chuẩn bị] (X003) ON, [Đèn chỉ thị sẵn sàng] (Y000) OFF và không 
khóa.. 

(2) Khi nhấn công tắc [Khởi động/Dừng quạt] trong khi đèn chỉ thị [Sẵn sàng] (Y000) ON,  
côngtăctơ điện từ cho quạt (Y002) được kích hoạt và quạt khởi động hoặc dừng.

     Tốc độ gió của quạt có thể được chọn bằng công tắc lựa chọn (X005/X006).
•	 Khi X005 ON: Ngõ ra gió yếu (Y001) ON.
•	 Khi X006 ON: Ngõ ra gió mạnh (Y003) ON.

Bố trí I/O
Ngõ vào

X000 Công tắc (Khởi động/Dừng quạt)
X001 Công tắc (Chuẩn bị)
X003 Công tắc (Hủy chuẩn bị)
X005 Lựa chọn (Gió yếu)
X006 Lựa chọn (Gió mạnh)

Ngõ ra
Y000 (Đèn chỉ thị sẵn sàng)
Y001 Ngõ ra gió yếu
Y002 Côngtăctơ điện từ cho quạt
Y003 Ngõ ra gió mạnh

     Đèn chỉ thị sẵn sàng        Gió yếu  Gió mạnh
Y000

Chuẩn bị
X001

   Khởi động/Dừng quạt
X000

Hủy chuẩn bị
X003

X005 X006 Quạt

Công tắc từ
Y002

Ngõ ra gió yếu
Y001

Ngõ ra gió mạnh
Y003
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•	Tham khảo Đáp án tại trang cuối của Chương này.
•	Tham khảo Phụ lục về chương trình danh sách lệnh.

Chương trình mạch
Nhập các thiết bị yêu cầu vào chỗ trống và hoàn tất chương trình.

Y000

Y002 Y003

Khóa liên động

Y001

Y001

Y0000

4

16 END

Y002

Y003
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5.4 Ví Dụ Tham khảo 4 (Điều Khiển Máy Ép)

Hãy cùng xem xét một chương trình PLC cho máy ép.

Vận hành
(1) Khi công tắc băng tải [Khởi động] (X001) ON, băng tải (Y003) ON và mang các chi tiết 

đến vị trí ép. 
Khi cảm biến đếm chi tiết (X004) dò tìm thấy 4 chi tiết, băng tải mang chi tiết (Y003) OFF 
và dừng mang chi tiết.

(2) Khi băng tải (Y003) dừng, còi khởi động ép (Y001) sẽ reng.
	 Sau 1 giây, máy ép sẽ thực hiện ép (Y002)
(3) Máy ép hoàn tất ép (Y002) trong 2 giây, còi khởi động (Y001) sẽ chuyển sang OFF.
(4) Sau khi việc ép hoàn tất, việc đếm chi tiết ép được thiết lập lại và vận hành được lặp lại 

từ bước (1).

Bố trí I/O
Ngõ vào

X001 Công tắc băng tải
X004 Cảm biến đếm chi tiết

Output
Y001 Còi khởi động ép
Y002 Ngõ ra ép
Y003 Băng tải

Băng tải
Y003

Công tắc băng tải
X001

Cảm biến đếm chi tiết
X004

Ngõ ra ép Y002

Còi khởi động ép
Y001

Quy trình xử lý

Chạy
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Chương trình mạch
Nhập thiết bị yêu cầu vào chỗ trống và hoàn tất chương trình.

X004

X001 C0

Y003

0

4

8

21

18

END

C0
Y001

T0

Y002

T1

K10

K20

C0RST

•	 Tham khảo Đáp án tại trang cuối của Chương này.
•	 Tham khảo phụ lục về chương trình danh sách lệnh.
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5.5 Ví Dụ Tham khảo 5 (Biểu Đồ Thời Gian)
Hãy cùng xem xét một chương trình PLC for cho biểu đồ thời gian bên dưới.

Vận hành
Khi công tắc khởi động (X001) được ON, đèn chỉ thị (Y000) ON và bộ hẹn giờ(T0) bắt đầu 
đo thời gian vào cùng thời điểm.
Khi bộ hẹn giờ (T0) đến giá trị cài đặt 2 s sau, còi (Y001) ON và bộ hẹn giờ (T1) bắt đầu 
đếm thời gian vào cùng thời điểm.
Sau đó, côngtăctơ điện từ (Y002), động cơ (Y003) và van điện từ (Y004) sẽ lần lượt ON 
trong khoảng thời gian 2s giống nhau. Sau khi van điện từ cuối cùng (Y004) vẫn ON trong 
2s, tất cả ngõ ra OFF.

Bố trí I/O
Ngõ vào

X001 Công tắc khởi động
Ngõ ra

Y000 Đèn chỉ thị
Y001 Còi
Y002 Côngtắctơ điện từ
Y003 Động cơ
Y004 Van điện từ

Công tắc khởi động

Thời gian: 2 giây

Thời gian: 2 giây

Thời gian: 2 giây

Thời gian: 2 giây

Thời gian: 2 giây

Đèn chỉ thị

Còi

Công tắc từ

Động cơ

Van điện từ

X001

Y000

Y001

Y002

Y003

Y004



95

Chương trình mạch  
Nhập thiết bị phù hợp vào chỗ trống và hoàn tất chương trình.

T0

X001 T4
0

7

12

22

27

17

END

Y000

K20

T1

T2

T3

T0

•	 Tham khảo Đáp án tại trang cuối của chương này..
•	 Tham khảo Phụ lục về chương trình danh sách lệnh.
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5.6 Đáp án ví dụ tham khảo

Ví dụ tham khảo 
3

X001

Y000

X003

X000

X005

X006

Ví dụ tham khảo 
4

Y003

C0 K4

T0

T1

Ví dụ tham khảo 
5

Y000

Y001

T1 K20

Y002

T2 K20

Y003

T3 K20

Y004

T4 K20
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Lập trình bằng máy tính cá nhân!

Phụ lục 1 
VẬN HÀNH GX Developer
Việc sử dụng máy tính cá nhân giúp điều khiển 
tuần tự trở nên dễ dàng hơn…   

Việc lập và biên soạn chương trình tuần tự trên máy tính thông qua GX Developer khiến việc 
lập trình trở nên đơn giản hơn nhờ các hỗ trợ của hình ảnh.
Khi bạn đã nắm vững các thao tác cơ bản, phần còn lại sẽ rất đơn giản.
Phần mềm được tích hợp nhiều chức năng dễ sử dụng, đầu tiên, chúng ta hãy cùng học từ 
những thao tác đơn giản nhất.

Khởi động và hiệu chỉnh dễ dàng…   
Chương trình được tích hợp tính năng sửa lỗi.
Trạng thái vận hành của PLC và chương trình có thể được quan sát trên màn hình máy tính 
cá nhân, vì thế chúng ta có thể dễ dàng phát hiện và hiệu chỉnh những lỗi vận hành trong 
quá trình quan sát.

Hỗ trợ đọc chương trình…   
Trong GX Developer được tích hợp "Chức năng nhập ghi chú" để hỗ trợ việc đọc các chương 
trình tuần tự.
Chức năng nhập ghi chú giúp nâng cao tính hiệu quả của việc lập trình và biên tập.
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Phụ lục 1.1 Kiến thức cơ bản khi vận hành GX Developer
Phụ lục 1.1.1. Cấu trúc của màn hình GX Developer

1)	 Thanh tiêu đề 
Thể hiện tên của thiết kế đang mở và biểu tượng vận hành các cửa sổ hiển thị.

    1) Thanh tiêu đề

    6) Thanh trạng thái

  2) Thanh trình đơn

   3) Thanh công cụ

5) Màn hình biên soạn

    4) Danh sách thiết kế

Thay đổi kích thước của GX Developer và thoát Phóng to hết cỡ và thu nhỏ lại GX Developer

Thoát khỏi GX DeveloperThu nhỏ hết cỡ GX DeveloperHiển thị của tên thiết kế 
và đường dẫn của nó

    1) Thanh tiêu đề

    6) Thanh trạng thái

  2) Thanh trình đơn

   3) Thanh công cụ

5) Màn hình biên soạn

    4) Danh sách thiết kế
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2)	 Thanh trình đơn

Khi click chuột vào trình đơn, thanh trình đơn sẽ trải xuống.

3)	 Thanh công cụ

* : �Các nội dung của thanh công cụ có thể được di chuyển, thêm vào hoặc tháo rời khỏi thanh công cụ, các 
nội dung hiển thị và bố trí cũng phụ thuộc vào các môi trường khác nhau..

4)	 Danh sách dữ liệu thiết kế

Cửa sổ tạo lệnh bậc thang, màn hình cài đặt thông số... sẽ được hiển thị trên cây thư mục.

M ô  t ả  c h ứ c 
năng sẽ được 
h i ể n  t h ị  k h i 
bạn đưa chuột 
đến gần các 
nút.

Chọn các mục trực tiếp  bằng 
cách click chuột..

Các chức năng thường dùng sẽ được hiển thị ngay trên thanh trình đơn. Bạn có thể thực 
hiện trực tiếp các chức năng thay vì lựa chọn từ thanh trình đơn.
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5)	 Màn hình biên soạn

6)	 Thanh trạng thái 
Trạng thái vận hành và cài đặt được hiển thị.

5) Màn hình biên soạn

Trạng thái Scroll Lock 

Chỉ dẫn của loại vị trí 
con trỏ

Loại
CPU 

Nơi CPU được kết
nối

Trạng thái
Caps Lock
 

Trạng thái
Num Lock 

Chế độ nhập hiện hành hiển thị

    Màn hình tạo lệnh bậc thang, màn hình quan sát... sẽ được hiển thị cùng lúc dưới hình thức các 
cửa sổ.
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Phụ lục 1.1.2   Project "Thiết kế"

Các Project "Thiết kế" sẽ bao gồm Chương trình, Ghi chú, Thông số và Bộ nhớ thiết bị.
Tổng các chuỗi dữ liệu trong GX  Developer  gọi là Project "Thiết kế" và được lưu trữ trong 
một thư mục của Windows®..

●● Biên soạn nhiều thiết kế  
Khi biên soạn trên hơn một thiết kế trong GX Developer, ta có thể khởi động cùng lúc nhiều 
GX Developer.

Thiết kế

Chương trình

Ghi chú

Thông số

Bộ nhớ thiết bị

Tương đương với thư mục của Windows®.

Chương trình tuần tự

Ghi chú trên các thiết bị

Dữ liệu cài đặt thông số PLC

Nội dung của các thiết bị hiện tại hoặc giá trị thiết bị nhập vào
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Phụ lục 1.2 Khởi động GX Developer và tạo một thiết kế mới
Phụ lục 1.2.1 Khởi động GX Developer

1)	 Chọn Start  trong Windows® và thực hiện 
theo thứ tự sau.. 
[Programs] 
             ↓ 
[MELSOFT Application] 
             ↓ 
[GX Developer]

2)	 GX Developer được khởi động.



103

1)	 Chọn  từ thanh công cụ, hoặc Chọn [Project] 
→ [New project] ( Ctrl  + N ) từ trình đơn.

Phụ lục 1.2.2 Tạo một thiết kế mới

2)	 Nhấp nút [▼] trong mục [PLC series].
3)	 Chọn "FXCPU".

4)	 Nhấp nút [▼] trong mục [PLC type].
5)	 Chọn "FX3U(C)". 

Chú ý : Chọn tên dòng thiết bị sử dụng thực tế

1) Nhấp

1) Nhấp

 3) Nhấp và chọn

2) Nhấp

 5) Nhấp và chọn

4) Nhấp
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6)	 Chọn OK .

7)	 Màn hình thiết kế mới hiển thị và chương 
trình đã sẵn sàng để nhập nội dung..

6) Nhấp

7) Màn hình thiết kế mới
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Phụ lục 1.3  Tạo chương trình
Phụ lục 1.3.1 Tạo chương trình bằng phím chức năng

[Chương trình được tạo]

X002
Y000

Y000

X000

X003
Y001

•	 Các phím chức năng và ký hiệu phần tử bậc thang được thể hiện trên các nút của thanh công cụ. 
 
                                                                          Các vận hành phím chính  
 
 
 
 
 
 
 
 

•	 Khi tạo chương trình, phải cài đặt sang chế độ "Write Mode". 
Chọn từ thanh công cụ. 		            Chọn từ trình đơn  ([Edit] → [Write mode]). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

•	 Dùng các ký tự độ rộng bán phần khi nhập. Không sử dụng các ký tự độ rộng toàn phần. 

Lưu ý

F5 F6 F7

F8

F9

F5

Shift Shift

F6

Shift

F9

Ctrl

F10

F9

Ctrl
+

++++

Trong tài liệu này, số của các rơle ngõ 
vào và ngõ ra được hiển thị là số có 3 
chữ số như "X000", "Y000".

Tuy nhiên, khi nhập số vào máy tính, 
số "0" cạnh các chữ X0, Y1 có thể bị 
lược bỏ.

Lưu ý
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1)	 Nhấn F5   .                                           
Nhập "X2".

6)	 Ngõ vào bậc thang 
X0

 hiển thị.
7)	 Nhấn phím F7   . 

Nhập "Y0".
8)	 Xác nhận bằng nhấn Enter  hoặc [OK].

9)	 Ngõ vào bậc thang  hiển thị.
10)	�Nhấn phím Shift  + F5   . 

Nhập "Y0".
11)	Xác nhận bằng nhấn Enter  hoặc [OK].

3)	 Ngõ vào bậc thang 
X2

 hiển thị.
4)	 Nhấn phím F6   . 

Nhập "X0".
5)	 Xác nhận bằng nhấn Enter  hoặc [OK].

Hủy bằng cách nhấn ESC  
hoặc chọn [Exit].

2)	 Xác nhận bằng nhấn Enter  hoặc chọn [OK].

1) Nhập "X2"   2) Nhấn phím Enter 

4) Nhập "X0"

3) Phần tử lệnh bậc thang hiển thị

  5) Nhấn phím    Enter  

6) Phần tử lệnh bậc thang hiển thị

7) Nhập "Y0"   8) Nhấn phím    Enter  

  11) Nhấn phím    Enter  10) Nhập "Y0"

9) Phần tử lệnh bậc thang hiển thị
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12)	  Ngõ vào bậc thang 
Y0

 hiển thị.
13)	  �Di chuyển con trỏ đến chỗ bắt đầu dòng tiếp 

theo.
14)	  �Nhấp F5   . 

Nhập "X3".
15)	  Xác nhận bằng phím Enter  hoặc chọn [OK].

16)	  Ngõ vào bậc thang 
X3

 hiển thị.
17)	  �Nhấp F7   . 

Nhập "Y1".
18)	  Xác nhận bằng phím Enter  hoặc [OK].

19)	  �Ngõ vào bậc thang  hiển thị.

12) Phần tử lệnh bậc thang hiển thị

13) Di chuyển con trỏ

  15) Nhấn phím    Enter  14) Nhập "X3"

17) Nhập "Y1"   18) Nhấn phím    Enter 

16) Phần tử lệnh bậc thang hiển thị

19) Phần tử lệnh bậc thang hiển thị

F4  (Chuyển đổi)

20) Vùng bóng xám biến mất.
20)	  �Vận hành chuyển đổi [Quan trọng] 

Thực hiện vận hành "Chuyển đổi" để xác 
nhận bậc thang chưa được soạn (phần màu 
xám). 
 
Nhấn nút F4  (Chuyển đổi) hoặc chọn  
từ thanh công cụ, hoặc chọn [Convert] → 
[Convert] từ trình đơn.

Vùng bóng xám biến mất và chương trình
được xác nhận.
Nếu có lỗi xảy ra,  con trỏ di chuyển đến phần 
có vấn đề của chương trình. Hãy sửa chương
trình.
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Phụ lục 1.3.2 Tạo chương trình bằng thanh công cụ

[Chương trình được tạo]

•	 Nhấp các nút thanh công cụ để nhập các phần tử bậc thang. 
 
                                                                              Các nút thanh công cụ chính 
 

•	 Khi tạo chương trình, phải cài đặt sang chế độ "Write Mode". 
Chọn từ thanh công cụ.                           Chọn từ trình đơn ([Edit] → [Write mode]). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

•	 Dùng các ký tự độ rộng bán phần khi nhập. Không sử dụng các ký tự độ rộng toàn phần.

Lưu ý

X002
Y000

Y000

X000

X003
Y001

Trong tài liệu này, số của các rơle ngõ 
vào và ngõ ra được hiển thị là "X000", 
"Y000" bởi 3 chữ số.

Tuy nhiên, số "0" ở bên trái chữ X0, Y1 
có thể được lược bỏ khi ngõ vào được 
thực hiện ở GX Developer.. 

Lưu ý
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6)	 Ngõ vào bậc thang 
X0

 hiển thị.
7)	 Nhấn  trên thanh công cụ. 

Nhập "Y0".
8)	 Xác nhận bằng nhấn  Enter  hoặc chọn [OK].

9)	 Ngõ vào bậc thang  hiển thị.
10)	�Nhấn   . 

Nhập "Y0".
11)	Xác nhận bằng nhấn  Enter  hoặc chọn [OK].

Hủy bằng nhấn ESC  hoặc [Exit].

3)	 Ngõ vào bậc thang  
X2

 hiển thị.
4)	 Nhấn  trên thanh công cụ . 

Nhập "X0".
5)	 Xác nhận bằng nhấn Enter  hoặc chọn [OK].

2)	 Xác nhận bằng nhấn Enter  hoặc chọn [OK].

1)	 Chọn  trên thanh công cụ. 
Nhập "X2".

2) Nhấp1) Nhập "X2"

5) Nhấp4) Nhập "X0"

3) Phần tử lệnh bậc thang hiển thị.

8) Nhấp7) Nhập “Y0”

6) Phần tử lệnh bậc thang hiển thị

11) Nhấp10) Nhập “Y0”

9) Phần tử lệnh bậc thang hiển thị.
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12)	  Ngõ vào bậc thang 
Y0

 hiển thị.
13)	  �Di chuyển con trỏ đến vị trí bắt đầu dòng kế 

tiếp.
14)	  �Nhấp vào  trên thanh công cụ. 

Nhập "X3".
15)	  Xác nhận bằng nhấn  Enter  hoặc [OK].

16)	  Ngõ vào bậc thang  
X3

 hiển thị.
17)	  �Nhấp vào  trên thanh công cụ. 

Nhập "Y1".
18)	  Xác nhận bằng nhấn  Enter  hoặc [OK].

19)	  �Ngõ vào bậc thang  hiển thị.

13) Rê con trỏ

12) Phần tử lệnh bậc thang hiển thị

15) Nhấp14) Nhập "X3"

18) Nhấp17) Nhập "Y1"

16) Phần tử lệnh bậc thang hiển thị

19) Phần tử lệnh bậc thang hiển thị

F4  (Convert)

20) Vùng bóng xám biến mất.

20)	  �Vận hành chuyển đổi [Quan trọng] 
Thực hiện vận hành "Chuyển đổi" để kết 
thúc bậc thang chưa được soạn (phần 
màu xám)  
Nhấn phím  F4  (Chuyển đổi). 
hoặc chọn   trên thanh công cụ, hoặc 
chọn [Convert] → [Convert] từ trình đơn.

Vùng bóng xám biến mất và chương trình 
được biên soạn.
Nếu có lỗi xảy ra,  con trỏ sẽ di chuyển đến 
phần có vấn đề của chương trình. Hãy sửa 
chương trình.
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Phụ lục 1.4  Viết chương trình vào PLC
Viết chương trình tuần tự đã tạo vào PLC FX.

Phụ lục 1.4.1  Kết nối máy tính với PLC

Kết nối máy tính cá nhân với PLC FX3G (bằng cáp USB)
[Chuẩn bị trên máy tính cá nhân]
Để kết nối máy tính cá nhân với PLC FX3G bằng cáp USB, đầu tiên bạn phải cài đặt phần 
mềm điều khiển Driver cho USB vào máy tính cá nhân.
Cài đặt Driver cho USB theo quy trình được mô tả trong “Tài liệu Hướng Dẫn Sử dụng GX 
Developer (Bản phổ cập)”.

Cổng (USB) 
của  PLC

Cáp USB 

USB

GX Developer

[Sơ đồ kết nối]
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Phụ lục 1.4.2 "Transfer Setup” trong GX Developer

Thiết lập cấu hình cài đặt của GX Developer để giao tiếp với PLC.

1)	 Chọn [Online] → [Transfer Setup].
2)	 Nhấp hai lần vào biểu tượng  .

3)	 Chọn cổng kết nối trên máy tính cá nhân.Chọn 
"USB (GOT transparent mode)" để kết nối với 
cổng USB có trên PLC FX3G 

4)	 Chọn [OK] sau khi hoàn tất cài đặt.

5)	 Chọn [Connection test], để kiểm tra kết nối với 
PLC.

6)	 Sau khi kiểm tra, nhấp [OK] để xác nhận.

1) Transfer Setup hiển thị

2) Nhấp 2 lần

3) (a)

3) (b)

3) (c)

4) Nhấp

5) Nhấp

6) Nhấp
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Phụ lục 1.4.3  Viết chương trình vào PLC

1)	 Cài đặt công tắc "RUN/STOP" của PLC sang 
"STOP".

3)	 Nhấp [Param + Prog].
4)	 Nhấp [Execute].

2)	 �Chọn   trên thanh công cụ hoặc nhấp chọn  
[Online] → [Write to PLC] từ trình đơn.

5)	 Nhấp [OK] sau khi hoàn tất.

2) Nhấp

4) Nhấp

3) Chọn dữ liệu 
    được viết

5) Nhấp

Hộp thoại xử lý quy trình thực hiện hiển thị.

1) Cài đặt 
  sang "STOP"
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Phụ lục 1.4.4  Quan sát vận hành PLC

1)	 Cài công tắc "RUN / STOP" của PLC sang 
"RUN". 

1)	 Cài đặt [Công tắc X002 "ON"] và [Công tắc X000 "OFF"], rồi kiểm tra [Ngõ ra Y000 "ON"].
2)	 Kiểm tra [Ngõ ra Y000 "ON"] trong khi [Công tắc X002 "OFF"].
3)	 Cài đặt [Công tắc X000 "ON"] và rồi kiểm tra [Ngõ ra Y000 "OFF"].
4)	 Kiểm tra [Ngõ ra Y001 "ON/OFF"] theo [Công tắc X003 "ON/OFF"].

 2) Nhấp

2)	 Chọn   từ thanh công cụ hoặc [Online] → 
[Monitor] → [Monitor mode] từ trình đơn.

1) Cài đặt sang
    "RUN"

Kiểm tra vận hành bằng chế độ quan sát
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(1) Hiển thị của hộp thoại trạng thái quan sát

4)3)2)1)

(2) Giải thích hiển thị quan sát lệnh bậc thang

Tham khảo

1)	 Thời gian quét  
Thời gian quét là thời gian cực đại của 
chương trình tuần tự được hiển thị.

2)	 Trạng thái PLC 
Trạng thái của PLC được hiển thị.

3)	 Trạng thái thực hiện quan sát 
Biểu tượng này sáng lên khi bạn đang ở 
trong chế độ quan sát.

4)	 Loại bộ nhớ 
Loại bộ nhớ của PLC được hiển thị.

1)	 Lệnh Tiếp điểm
Tiếp điểm ngõ vào

Loại X0: OFF X0: ON

Tiếp điểm thường mở
X000

Tiếp điểm mở

X000

Tiếp điểm đóng

Tiếp điểm thường đóng
X000

Tiếp điểm đóng

X000

Tiếp điểm mở

2)	 Lệnh ngõ ra
Trạng thái điều khiển

Loại
Không thực hiện/
Không điều khiển Thực hiện/Điều khiển

Lệnh OUT
Y000 Y000

Lệnh SET... SET M0 SET M0

Trạng thái ON/OFF của thiết bị được reset sẽ hiển thị qua chế độ quan sát bằng lệnh RST
Trạng thái thiết bị

Loại
Khi thiết bị được 

reset OFF
Khi thiết bị được 

reset ON

Lệnh RST
RST M0 RST M0



116

Phụ lục 1.5  Soạn chương trình
Phụ lục 1.5.1  Hiệu chỉnh chương trình

•	 Phải cài đặt thành chế độ "Write Mode" khi sửa mạch. 
Chọn từ thanh công cụ.                             Chọn từ trình đơn ([Edit]→[Write mode]). 
 
 
 
 
 
 
 
 
 
 
 
 
 

•	 Chuyển đổi giữa "Ovrwrte" và "Insert" 
  • Cài đặt chế độ "Ovrwrte" khi sửa và viết chồng lệnh bậc thang. 
  • Bậc thang mới sẽ được chèn khi chế độ "Insert" được mở.

Lưu ý

Chuyển đổi giữa
"Ovrwrte" và "Insert"

bằng nhấn phím Insert   
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1) Thay đổi các cuộn và tiếp điểm OUT

[Chương trình cần sửa]

3)	 Xác nhận bằng nhấn Enter  hoặc [OK].
4)	 Kết quả sửa được hiển thị và khối lệnh bậc 

thang hiển thị màu xám.

1)	 Nhấp 2 lần vào vị trí cần sửa.

5)	 Xác nhận các thay đổi bằng nhấn F4  
(Chuyển đổi) .

X002

Y000

X000

X003
Y001

Y002

Y000

Đổi thành

2)	 Đổi "Y001" thành "Y002".

1) Nhấp 2 lần

2) Đổi  "Y002"   3) Nhấn phím    Enter  

5) F4 (Convert)

4) Kết quả sửa được hiển thị
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2) Thêm dòng

[Chương trình được sửa]

3)	 Hàng sẽ được thêm vào đến vị trí thả chuột.
4)	 Định vị con trỏ tại vị trí sẽ thêm cuộn OUT và 

nhấp vào   trên thanh công cụ.

1)	 Nhấp  ( F10 ) trên thanh công cụ. 

X002

Y000

X000

X003
Y001

Y000

Y003

Thêm các hàng đứng/
ngang tạo cuộn OUT

2)	 Định vị con trỏ ở góc trên bên phải của hàng 
đứng tại vị trí sẽ chèn thêm dòng và rê chuột 
đến vị trí mong muốn, rồi thả chuột.

5)	 Nhập "Y3".
6)	 Xác nhận bằng nhấn Enter  hoặc [OK].

1) Nhấp

2) Rê

Định vị con trỏ ở góc trên bên phải ở chỗ bắt
đầu dòng sẽ được thêm vào.

5) Đổi  "Y3"   6) Nhấn phím    Enter  

Hàng thêm vào

4) Vị trí con trỏ
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8)	 Xác nhận các thay đổi bằng cách nhấn F4  
(Chuyển đổi). Nhấp  trên thanh công cụ lần 
nữa để hoàn tất vận hành.

7)	 Bậc thang thêm vào hoàn tất và khối lệnh bậc 
thang sẽ hiển thị màu xám.7) Bậc thang thêm 

    vào hoàn tất

8) F4 (Chuyển đổi)
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3) Xóa dòng

[Chương trình nơi dòng được xóa]

3)	 Hàng được xóa.
4)	 Xóa cuộn OUT bằng phím Delete  .

1)	 Nhấp   Alt  + F9  trên thanh công cụ.

X002

Y000

X000

X003
Y001

Xóa bậc 
này

Y000

Y003

2)	 Định vị con trỏ ở góc trên bên phải của hàng 
đứng muốn xóa và rê chuột đến vị trí mong 
muốn, rồi thả chuột.

1) Nhấp

2) Rê

Định vị con trỏ ở góc trên bên phải 
của hàng đứng được xóa

3) Hàng được xóa

4) Xóa hàng bằng phím Delete  
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5)	 Phần được xóa sẽ có màu xám.

6)	 Xác nhận các thay đổi bằng nhấn F4 .

•  Nhấp  trên thanh công cụ lần nữa để 
hoàn tất vận hành.

6) F4 (Chuyển đổi)
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Phụ lục 1.5.2.  Chèn và xóa hàng

1) Thêm hàng
[Chương trình có bậc thang được chèn vào]

3)	  Hàng mới chèn vào.

X002

Y000

X000

X003
Y001

Thêm bậc nàyX001

Y000

Y002

2)	 Nhấp chuột phải tại vị trí bất kỳ và chọn 
[Insert Row]. 

Hàng sẽ được chèn vào phía trên hàng có con 
trỏ.

1)	 Định vị con trỏ ở vị trí dưới hàng được chèn 
vào.

4)	 Thêm bậc thang vào hàng chèn vào.

5)	 Xác nhận các thay đổi bằng nhấn  Convert  
(F4).

   1) Di chuyển con trỏ đến hàng 
       bên dưới hàng được chèn

Chọn "Insert Row"

2) Nhấp 
    chuột 
    phải

3) Hàng mới được chèn vào

4) Thêm bậc
X001

Y002
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2) Xóa hàng

[Chương trình có hàng được xóa]

3)	 Hàng được xóa.

1)	 Di chuyển con chuột đến hàng được xóa

X002

Y000

X000

X003
Y001

Xóa hàng này

X001

Y000

Y002

2)	 Nhấp chuột phải ở vị trí bất kỳ và chọn 
[Delete Row]

Hàng được xóa hiển thị màu xám.

Xác nhận bằng nhấn Convert  (F4).

Lưu ý

1) Di chuyển con trỏ đến
    hàng cần xóa

Chọn "Delete Row"

2) Nhấp 
    chuột 
    phải

3) Hàng được xóa
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Phụ lục 1.5.3 Cắt và chép (dán) bậc thang
1) Cắt

[Chương trình được biên soạn]

1)	 Di chuyển con trỏ đến vị trí bắt đầu bậc thang 
được cắt.

X002

Y002

X000

X004
Y004

X007

Y002

Y007
Cắt hàng này

2)	 Kéo chuột đến vị trí mong muốn, rồi thả tay.
3)	 Chọn  từ thanh công cụ hoặc chọn [Edit] 

→ [Cut] ( Ctrl  + X ) từ trình đơn và thực 
hiện cắt.

4)	 Vùng chọn được cắt. 
Nếu chỉ cắt một phần của bậc thang, vùng 
màu xám sẽ vẫn còn hiển thị. Do đó, sau khi 
sửa bậc thang, bạn phải xác nhận các thay 
đổi bằng cách nhấn  F4  (Chuyển đổi). 

Vùng cắt và chép1) Dời con trỏ đến chỗ
    bắt đầu của vùng
    cắt

2) Rê  đến  vị  trí  mong  muốn  rồi
    bỏ  ra

3) Thực hiện cắt

4) Vùng chọn
    được cắt
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1)	 Di chuyển con trỏ đến vị trí bắt đầu của bậc 
thang cần chép..

2)	 Kéo chuột đến vị trí mong muốn rồi thả tay.
3)	 Chọn   từ thanh công cụ hoặc chọn [Edit] 

→ [Copy] ( Ctrl  + C ) từ trình đơn.

5)	 Chọn   ftừ thanh công cụ hoặc chọn [Edit] 
→ [Paste] ( Ctrl  + V ) từ trình đơn. 
Nếu chỉ dán một phần bậc thang, vùng màu 
xám sẽ vẫn hiển thị. Do đó, sau khi sửa, bạn 
phải xác nhận thay đổi bằng cách nhấn F4  
(Chuyển đổi).

4)	 Di chuyển con trỏ đến vị trí cần dán.

Chuyển đổi bằng nút  Insert  

Chế độ "Ovrwrte" : Dán bằng viết chồng 

dữ liệu tại vị trí con trỏ.

Chế độ "Insert": Dán bằng chèn dữ liệu 

lên phía trên vị trí con trỏ.

Lưu ý

2) Chép (Dán)

1) Dời con trỏ đến chỗ bắt
    đầu của vùng chép

3)Thực hiện
    chép

2) Rê nó đến vị trí mong muốn
    rồi bỏ ra

4) Dời con trỏ đến nơi
    cần dán

5) Hoàn tất chép/dán

Y000

X004

X000

X002
Y000

X002
Y000

Y000

X000

Y004

Chép hàng
này

 

Dán nó vào
hàng này
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Phụ lục 1.6  Lưu chương trình
Phụ lục 1.6.1  Lưu mới và lưu chồng

(Khi lưu bằng viết chồng)

Hoàn tất lưu thiết kế. 

Nếu có bậc thang chưa được biên soạn, hãy lưu chương trình sau khi hoàn tất thao tác Convert  (F4)
 

Lưu ý

1)	 Chọn  từ thanh công cụ hoặc chọn 
[Project]→ [Save] ( Ctrl  + S ) từ trình đơn.

6)	 Nhấp Yes  trong hộp thoại xác nhận để 
hoàn tất.	

Nếu không đủ khoảng trống trong đĩa mềm để 
lưu thiết kế, bạn có thể lưu tạm vào ổ cứng trước 
khi di chuyển đến ổ mềm khác.

2)	 Xác định vị trí lưu trữ cho thiết kế.
3)	 Xác định tên thiết kế.
4)	 Xác định tiêu đề mô tả thiết kế (tùy chọn).
5)	 Nhấp Save .

Tham khảo

1) Nhấp

3) Xác định tên thiết kế

2) Xác định đích lưu trữ
    cho thiết kế

5) Nhấp

4) Xác định tiêu đề (tùy chọn)

6) Nhấp

(Khi lưu mới)

•	 Không được dùng các ký tự sau trong tên thiết kế. 
/ ,\ ,> ,< ,* ,? ,” ,“ , | , : , ; ( ; ,  \ chỉ được dùng để xác định driver) 
Ngoài ra, không dùng dấu  “.” (chấm) ở cuối tên thiết kế.

•	 Khi tên thiết kế được xác định bằng 8 ký tự hoặc nhiều hơn trong GX Developer (từ sau phiên bản 
SW6D5- GPPW), các ký tự sau ký tự thứ 8 sẽ không hiển thị nếu đọc bằng các phiên bản cũ (trước 
SW2D5-GPPW) của GX Developer.

•	 Tổng số ký tự trong tên Đường dẫn thiết kế + Tên thiết kế = 150 ký tự 1 byte (hoặc 75 ký tự 2 bytes).

•	 Chiều dài tiêu đề giới hạn trong 32 ký tự.

•	 Nếu có các khoảng trắng trong đường dẫn và tên thiết kế, GX Developer sẽ không khởi động bình 
thường khi bạn click chuột 2 lần vào tên GPPW.gpj, ***.gps trong cửa sổ Explorer .

•	 Nếu có các khoảng trắng trong đường dẫn và tên thiết kế, hãy mở thiết kế bằng cách khởi động GX 
Developer → Selecting [Project] → [Open Project] từ trình đơn.
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Nếu có bậc thang chưa được biên soạn, hãy save chương trình sau khi hoàn tất thao tác  Convert  (F4) 

Phụ lục 1.6.2  Lưu thiết kế bằng tên mới

1)	 Chọn [Project] → [Save as] từ trình đơn.

2)	 Xác định đích lưu trữ thiết kế.
3)	 Xác định tên thiết kế.
4)	 Xác định tiêu đề mô tả thiết kế (tùy chọn).
5)	 Nhấp Save .

6)	 Nhấp Yes  trong hộp thoại xác nhận và 
hoàn tất.

Xem cách đặt tên driver/đường dẫn và thiết kế ở 
trang trước.

Nếu không đủ khoảng trống trong đĩa mềm để 
lưu thiết kế, bạn có thể lưu tạm vào ổ cứng trước 
khi di chuyển đến ổ mềm khác.

1) Nhấp

3) Xác định tên thiết kế

2) Xác định đích lưu trữ
    cho thiết kế 

5) Nhấp

4) Xác định tiêu đề (tùy chọn)

6) Nhấp

Lưu ý
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Phụ lục 1.6.3  Đọc thiết kế

1)	 Select  từ thanh công cụ hoặc chọn 
[Project]→ [Open project]  ( Ctrl  + O ) từ 
trình đơn.

Nếu bạn mở một thiết kế khác trong khi thiết kế hiện tại đang chạy, thiết kế hiện hành sẽ đóng lại.

Nếu có bậc thang chưa được soạn trong thiết kế hoặc thiết kê không được lưu, màn hình sẽ hiện 

ra thông điệp báo hiệu

Tham khảo

2)	 Chọn nơi lưu trữ thiết kế.
3)	 Chọn thiết kế được đọc.
4)	 Nhấp Open  và đọc thiết kế.

1) Nhấp

3) Chọn thiết kế được đọc

4) Nhấp

2) Chọn đích lưu trữ
    của thiết kế
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Phụ lục 1.7  Thao tác sửa lỗi chương trình
Tham khảo "Phụ lục 1.4 viết chương trình vào PLC" về cách kết nối với PLC và viết chương trình vào PLC.

Phụ lục 1.7.1  Quan sát lệnh bậc thang
Hiển thị bậc thang và quan sát trạng thái thực hiện của các tiếp điểm và trạng thái điều khiển các cuộn.

2)	 Trạng thái ON/OFF của bậc thang và giá trị 
hiện tại của các thiết bị thông tin (bộ hẹn giờ, 
bộ đếm và bộ ghi dữ liệu) được hiển thị trong 
cửa sổ quan sát lệnh bậc thang.

3)	 Nhấp chuột phải vào cửa sổ, chọn [Stop 
Monitor] để thoát khỏi màn hình quan sát bậc 
thang.

4)	 Để sửa và viết chương trình, chọn  từ 
thanh công cụ hoặc chọn [Edit] → [Write 
Mode] từ trình đơn.

1)	 Chọn   từ thanh công cụ hoặc chọn 
[Online] → [Monitor] → [Monitor mode] từ 
trình đơn.
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(1) Hiển thị của hộp thoại trạng thái quan sát

4)3)2)1)

(2) Giải thích hiển thị quan sát lệnh bậc thang

Tham khảo

1)	 Thời gian quét 
Thời gian quét cực đại của chương trình 
tuần tự được hiển thị.

2)	 Trạng thái PLC 
Trạng thái của PLC được hiển thị.

3)	 Trạng thái thực hiện quan sát 
Biểu tượng này sáng khi bạn đang ở trong    
chế độ quan sát.

4)	 Loại bộ nhớ
	    Loại bộ nhớ của PLC được hiển thị.

1)	 Lệnh tiếp điểm
Tiếp điểm ngõ vào

Loại X0: OFF X0: ON

Tiếp điểm NO
X000

Tiếp điểm mở

X000

Tiếp điểm đóng

Tiếp điểm NC 
X000

Tiếp điểm đóng

X000

Tiếp điểm mở

2)	 Lệnh ngõ ra
Trạng thái điều khiển

Loại
Không thực hiện/

Không điều khiển
Thực hiện/Điều khiển

Lệnh OUT 
Y000 Y000

Lệnh SET
SET M0 SET M0

Trạng thái ON/OFF của thiết bị được reset hiển thị bởi quan sát sử dụng lệnh RST. 

Trạng thái thiết bị
Loại

Khi thiết bị được
reset là OFF

Khi thiết bị được
reset là ON

Lệnh RST
RST M0 RST M0
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Phụ lục 1.7.2  Quan sát đăng ký thiết bị

1) Đăng ký thiết bị tùy chọn
Đăng ký thiết bị tùy chọn trong cửa sổ quan sát để quan sát những phần cần thiết.

4)	 Nhập số thiết bị cần đăng ký trong cửa sổ 
Register device. 

5)	 Nhấn [Register].

6)	 Thiết bị được đăng ký trong cửa sổ quan sát.
7)	 Chọn [Start Monitor], các giá trị thể hiện hoạt 

động thiết bị và trạng thái ON/OFF của các 
tiếp điểm và cuộn sẽ hiển thị.

1)	 Cài đặt trạng thái quan sát bậc thang. (Tham 
khảo Phụ lục 1.7.1) 

2)	 Chọn [Online] → [Monitor] → [Entry data 
monitor] từ trình đơn. Hoặc nhấp chuột phải 
vào cửa sổ lệnh bậc thang và chọn [Entry 
data monitor].

3) Nhấp

Chọn "số nguyên 32 bit"
Khi muốn quan sát thiết
bị ở 32 bit.

4) Nhập thiết bị

5) Nhấp

7) Nhấp

3)	 Nhấp [Register Devices] trong cửa sổ "Entry 
Data Monitor".



132

1)	 Cài đặt chế độ quan sát. (Tham khảo Phụ lục 
1.7.1) 

2)	 Chọn [Online] → [Monitor] → [Entry data 
monitor] từ trình đơn. Hoặc nhấp chuột phải 
vào cửa sổ quan sát bậc thang và chọn [Entry 
datamonitor]. (Xem trang trước)

3)	 Chọn [Window] → [Tile horizontally] từ trình 
đơn để làm hiển thị đồng thời "Ladder monitor 
window" và "Entry data monitor window". (Cài 
"Entry data monitor window" sang trạng thái 
dừng quan sát).

4)	 "Ladder monitor window" và "Entry data 
monitor window" sẽ hiển thị nằm ngang.

5)	 Nhấp vào điểm đầu của bậc thang.

6)	 Nhấp vào điểm cuối + giữ phím [Shift]  để chọn 
vùng.

7)	 Kéo vùng đã chọn đến "Entry data monitor 
window".

2) Đăng ký thiết bị hiển thị trong quan sát bậc thang
Xác định vùng bậc thang trong cửa sổ quan sát bậc thang và đăng ký tất cả thiết bị trong vùng.

5) Nhấp vào điểm đầu của bậc thang.

6) Nhấp vào điểm cuối đồng thời
    nhấn [Shift] để chọn vùng

7) Rê

9) Nhấp

8)	 Thiết bị được đăng ký với cửa sổ quan sát.

9)	 Nhấp [Start Monitor], giá trị thể hiện hoạt động 
thiết bị và trạng thái ON/OFF của các tiếp điểm 
và cuộn được hiển thị.
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Phụ lục 1.7.3 Quan sát nhóm thiết bị
Xác định một thiết bị và quan sát một khoảng liên tục các thiết bị theo sau nó..

1)	 Thiết lập chế độ quan sát. (Tham khảo Phụ 
lục1.7.1)

2)	 Chọn [Online] → [Monitor] → [Device batch] 
từ trình đơn. Hoặc nhấp phải vào cửa sổ bậc 
thang và chọn [Device batch].

3) Nhập thiết bị

4)	 Giá trị thể hiện hoạt động thiết bị và trạng thái 
ON/OFF của các tiếp điểm và cuộn được hiển 
thị.

3)	 Nhập thiết bị đầu tiên của các thiết bị được 
quan sát trong cửa sổ "Device batch monitor", 
nhấn Enter  rồi nhấn[Start monitor].
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Phụ lục 1.7.4  Kiểm tra thiết bi

1) Cưỡng bức ON/OFF
Cưỡng bức ON/OFF các thiết bị bit của PLC (M, Y, T, C …). (Không có chức năng cưỡng bức ON/OFF 
của X).
Khi PLC đang chạy, chức năng cưỡng bức ON/OFF có thể mở hoặc tắt các thiết bị chỉ trong một chu 
kỳ vận hành. Các vận hành theo điều khiển tuần tự sẽ được ưu tiên.  Khi kiểm tra ngõ ra, bạn hãy cài 
đặt PLCsang trạng thái STOP.

1)	 Cài đặt chế độ quan sát. (Tham khảo Phụ lục 
1.7.1) 

2)	 Chọn [Online] → [Debug] → [Device test] từ 
trình đơn. Hoặc nhấp phải vào cửa sổ bậc 
thang và chọn [Device test].

ON/OFF cưỡng bức (Cửa sổ quan sát lệnh bậc thang)
Bất cứ thiết bị bit nào (tiếp điểm và cuộn) đều có thể được cưỡng bức ON/OFF bằng cách nhấp 2 

lần vào thiết bị đó trong [Ladder monitor window] + nhấn giữ phím [Shift] .

Tham khảo

3) Nhập thiết bị

4) Nhấp

3)	 Nhập số thiết bị sẽ cưỡng bức ON/OFF.

4)	 • [FORCE ON]: Cưỡng bức thiết bị ON. 
• [FORCE OFF]: Cưỡng bức thiết bị OFF. 
• �[Toggle force]: Cưỡng bức thiết bị chuyển 

đổi ON/OFF mỗi lần nhấn.
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2) Thay đổi giá trị hiện tại của thiết bị thông tin
Thay đổi giá trị hiện tại của thiết bị thông tin của PLC (T, C, D và còn nữa)

1)	 Cài sang chế độ quan sát. (Tham khảo Phụ 
lục  
1.7.1.) 

2)	 Chọn [Online] → [Debug] → [Device test] từ 
trình đơn. Hoặc nhấp phải vào cửa sổ lệnh 

3) Nhập thiết bị

5) Nhấp   4) Giá trị mới

bậc thang và chọn [Device Test].
3)	 Nhập số của thiết bị được thay đổi. 

4)	 Nhập giá trị mới. 

5)	 Nhấp [Set].
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Phụ lục 1.7.5    Viết chương trình vào PLC khi đang RUN
Viết phần sửa của lệnh bậc thang vào PLC khi PLC đang chạy.
Do toàn bộ phần lập trình sẽ không được truyền gửi do đó việc viết chương trình sẽ tốn ít thời gian 
hơn.

1)	 Chúng tôi sẽ giải thích thông qua ví dụ thêm 
tiếp điểm vào bậc thang bên trái. Ta cho hiển 
thị sơ đồ bậc thang rồi cài đặt chế độ viết  ( 

 ).

Bạn không thể viết chương trình vào PLC nếu chương trình trong PLC khác với chương trình 

trong GX Developer. Kiểm tra trước hoặc chuyển đổi chương trình trước khi viết thông qua [Write 

to PLC]. 

Lưu ý

2)	 Thêm tiếp điểm. 
Khối lệnh bậc thang hiển thị màu xám.

3)	 Nhấn [Shift] và [F4] với nhau hoặc chọn 
[Convert] → [Convert (Write during RUN)] từ 
trình đơn.

5)	 Thông điệp "RUN write processing has 
completed." hiển thị. Nhấp [OK].

2) Thêm tiếp điểm

4) Nhấp

5) Nhấp

Viết trong khi RUN	  [Shift]+[F4]

4)	 Nhấp [Yes] để xác nhận thông điệp cảnh báo 
an toàn PLC liên quan đến những thay đổi 
trực tuyến.
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Phụ lục 1.8  Nhập ghi chú
Phụ lục 1.8.1  Các loại ghi chú

Bạn có thể nhập 3 loại ghi chú sau đây :

Loại Mục đích
Số ký tự

(rộng toàn phần)
Ghi chú

1) Ghi chú thiết bị
Ghi chú mô tả vai trò và chức 

năng của mỗi thiết bị
16

Bạn cần cài đặt "Comments capacity" 

trong cài đặt thông số khi viết vào 

PLC. Ngoài ra, bạn cũng phải cài đặt 

"Comment Range Setting".

2) Hướng dẫn lệnh
Ghi chú mô tả vai trò và chức 

năng của các khối lệnh bậc thang
32

Đây là ghi chú trên phần GX Developer

(Không được tải xuống PLC).

3) Ghi chú
Ghi chú mô tả vai trò và chức 

năng của các lệnh ngõ ra.
16

Đây là ghi chú trên phần GX Developer

(Không được tải xuống PLC).

[Comment Examples]

Cách hiển thị ghi chú
•	 Chọn [Display] → [Display comment] từ trình đơn để làm hiển thị ghi chú.

•	 Lặp lại thao tác tương tự để tắt hiển thị ghi chú.

Lưu ý

Tiếp điểm T5 NO tồn  tại  ở  bước  10,
trong khi tiếp điểm T5 NC tồn  tại  ở  bước  8

3) Ghi chú

2) Hướng dẫn lệnh

1) Ghi chú

X000

Y000

Y000

T5

T7

          Khởi động 

 Đèn
Xanh

Thời gian 
dừng băng
tải

Mạch khởi động 

Cài thời gian còi

Đèn xanh

Bộ định thời 2s

0

4

8

<Nút Start mở đèn >

<Còi reng trong một lúc                 >

(Y000   )
Y000
A/S
A/S

1

T5
B/D
B/D

10
8

4
  Đèn
 Xanh

K20

(Y001   )
   Còi

T5
Bộ định
thời 2s
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Phụ lục 1.8.2  Vận hành tạo ghi chú thiết bị

1) Cách nhập ghi chú thiết bị từ danh sách

1)	 Nhấp 2 lần [Device comment] → 
[COMMENT] trong danh sách thiết kế.

1) Nhấp

2)	 Nhập số đầu tiên củatên thiết bị được ghi chú 
trong "Device name" và nhấp vào [Display]. 

3)	 Nhập các ghi chú vào cột "Comment". 
 
• �Khi nhập ghi chú cho thiết bị khác, nhập số 

thiết bị một lần nữa ở bước 2.

2) Nhập số thiết bị

3) Nhập ghi chú

1)	 Nhấp  từ thanh công cụ và nhấp 2 lần vào 
phần tử bậc thang cần ghi chú.

2)	 Nhập ghi chú vào cửa sổ "Enter symbol" và 
nhấp [OK]. 
• �Nhấp  trên thanh công cụ lần nữa để kết 

thúc. 

2) Cách nhập ghi chú thiết bị vào lệnh bậc thang

1) Nhấp 2 lần

2) Nhập ghi chú
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Lưu ý

Tham khảo

Cài đặt khi viết ghi chú thiết bị vào PLC

Bạn phải cài đặt "Parameter setting" và "Comment range setting" khi ghi chú thiết bị trong PLC.

1)	 Parameter setting (Cài đặt thông số)
•	Chọn [Parameter] → [PLC parameter] trong danh sách thiết kế.

•	Cài đặt "number of blocks" (Số khối) trong phần "Comments capacity". 
Mỗi khối tương đương với 50 ghi chú, chiếm 500-bước của bộ nhớ chương trình.

Cài đặt dung lượng ghi chú

Dung lượng của chương trình
giảm khi nhiều khối ghi chú
hơn được thêm vào

2) Comment range setting (Cài đặt phạm vi ghi chú)
•	Chọn [Device comment] → [Comment] để hiển thị màn hình nhập ghi chú.

•	Chọn [Edit] → [Setup comment range] từ trình đơn.

•	Cài đặt loại và khoảng thiết bị được ghi vào PLC trong hộp thoại Setup comment 
range. 

Cài đặt khoảng
ghi chú

Continues during command write

Chọn [Tool] → [Options] từ trình đơn, đánh dấu  
chọn "Continues during command write" của hộp 
[Comment input] trong tab [Program common].

Sau khi thiết lập cài đặt như trên, vận hành của 
ngõ vào bậc thang tiếp tục và cửa sổ "Enter 
symbol" được mô tả trong bước 2) hiển thị khi 
chương trình đang được tạo.
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Phụ lục 1.8.3  Thao tác tạo Lệnh

1)	 Nhấp   từ thanh công cụ và nhấp 2 lần  
vào vị trí bất kỳ trên khối lệnh bậc thang sẽ 
viết lệnh. 

2)	 Nhập hướng dẫn lệnh vào cửa sổ "Enter line 
statements" và nhấp [OK]. 
 

• �Nhấp  trên thanh công cụ lần nữa để 

hoàn tất.

Phụ lục 1.8.4  Vận hành tạo ghi chú

1)	 Nhấp  từ thanh công cụ và nhấp 2 lần vào 
biểu tượng lệnh ngõ ra nơi sẽ viết ghi chú. 

2)	 Nhập ghi chú vào cửa sổ "Enter Note" và 
nhấp [OK]. 
 

• �Nhấp  trên thanh công cụ lần nữa để 

hoàn tất.

1) Nhấp 2 lần

2) Nhập hướng dẫn lệnh

2) Nhập ghi chú

1) Nhấp 2 lần
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Phụ lục 1.9  Thao tác tạo danh sách chương trình
Trong GX Developer, chương trình cũng có thể được tạo bằng phương thức danh sách lệnh.

Phụ lục 1.9.1  Hiển thị màn hình soạn danh sách

1)	 Tạo thiết kế mới (Xem phần 1.2.2) hoặc hiển 
thị bậc thang của thiết kế hiện hữu.. 

2)	 Chọn   từ thanh công cụ hoặc chọn [View] 
→ [Instruction list] từ trình đơn.

Phụ lục 1.9.2  Cách nhập lệnh

1)	 Nhập ngôn ngữ lệnh theo thứ tự từ bước 0 
Số bước được thêm vào tự động khi lệnh 
được nhập. (Tham khảo phương pháp nhập 
trong trang kế tiếp). 

1) Màn hình soạn danh sách hiển thị

3) Màn hình soạn danh
    sách hiển thị

Màn hình ban đầu     Sau khi nhập danh sách

3)	 Màn hình soạn danh sách hiển thị. 
Nhấp  trên thanh công cụ lần nữa hoặc 
chọn [View] → [Ladder]  từ trình đơn để trở 
về hiển thị lệnh bậc thang.
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[Ví dụ cho các lệnh cơ bản]
LD 
OUT
LDI
AND
OUT
LD
OUT
OUT

[Ví dụ cho lệnh ứng dụng]
MOV
CMP

X0	 Enter

Y0	 Enter

X0	 Enter

Y0	 Enter

M0	 Enter

M0	 Enter

T0    K10	 Enter

C0    K5	 Enter

K1    D0  	 Enter

K20  D3  M10	 Enter

●● Cách nhập các lệnh cơ bản và lệnh ứng dụng

Một "khoảng trắng" được nhập giữa ngôn ngữ lệnh, số thiết bị và toán hạng.

Lệnh kết nối và lệnh OUT

Thao tác với phím khi nhập/ biên soạn

 • Chế độ "Ovrwrte"/"Insert" chuyển đổi bằng nhấn Insert  

 • Lệnh có thể được xóa bằng cách nhấn phím Delete  .

 • Thao tác [Insert line] và [Delete line] có thể được thực hiện khi nhấp chuột phải.

Tham khảo

Các lệnh cuộn cho bộ hẹn giờ và bộ đếm 



143

Phụ lục 1.9.3  Kiểm tra nội dung trong danh sách nhập
Bạn hãy kiểm tra để đảm bảo bậc thang hiển thị trong chương trình được nhập danh sách không có lỗi.

1)	 Chọn  từ thanh công cụ hoặc chọn [View] 
→ [Ladder] từ trình đơn.

2)	 Kiểm tra xem chương trình được tạo ra bởi 
việc nhập danh sách có hiển thị chưa.

3)	 Chọn [Tools] → [Check program] để thực hiện 
việc kiểm tra chương trình và kiểm tra xem có 
lỗi nào xảy ra hay không cũng như các bước 
lỗi.
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Phụ lục 2
Ví dụ tham khảo về Chương trình danh sách lệnh
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Ví dụ Tham khảo 1
Chương trình danh sách lệnh: Ví dụ 1

Chương trình danh sách lệnh: Ví dụ 2

Chương trình danh sách lệnh 

Chương trình danh sách lệnhChương trình danh sách lệnh

Step Command
0 LD X001
1 OR Y000
2 ANI X003
3 OUT Y000
4 OUT Y003
5 END

Step Command
0 LD X001
1 SET Y000
2 SET Y003
3 LD X003
4 RST Y000
5 RST Y003
6 END

Step Command
0 LD X000
1 AND X001
2 OUT Y001
3 LD X003
4 OR Y003
5 ANI X004
6 OUT Y003
7 LD Y003
8 OUT C0 K5
11 LD C0
12 OUT Y000
13 LD X002
14 RST C0
16 END

Ví dụ Tham khảo 2

Ví dụ Tham khảo 3

Step Command
0 LD X001
1 OR Y003
2 ANI C0
3 OUT Y003
4 LD X004
5 OUT C0 K4
8 LD C0
9 OUT Y001
10 OUT T0 K10
13 AND T0
14 OUT Y002
15 OUT T1 K20
18 LD T1
19 RST C0
21 END

Ví dụ Tham khảo 4

Step Command
0 LD X001
1 OR Y000
2 ANI X003
3 OUT Y000
4 LD Y000
5 AND X000
6 OUT Y002
7 AND Y002
8 MPS
9 AND X005
10 ANI Y003
11 OUT Y001
12 MPP
13 AND X006
14 ANI Y001
15 OUT Y003
16 END

Phụ lục 2.1 Chương trình danh sách lệnh
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Chương trình danh sách lệnh

Ví dụ Tham khảo 5

Step Command
0 LD X001
1 OR Y000
2 ANI T4
3 OUT Y000
4 OUT T0 K20
7 LD T0
8 OUT Y001
9 OUT T1 K20
12 LD T1
13 OUT Y002
14 OUT T2 K20
17 LD T2
18 OUT Y003
19 OUT T3 K20
22 LD T3
23 OUT Y004
24 OUT T4 K20
27 END
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Sử dụng bảng lập trình cầm tay (HPP)...
Giúp bạn có thể dễ dàng soạn chương trình theo phương thức Danh sách lệnh.

HPP hỗ trợ soạn thảo chương trình và sửa lỗi thiết bị tại công trường – những nơi 
không thuận tiện trong việc cài đặt máy tính cá nhân - thông qua việc thay đổi các 
chương trình đơn giản và thông số của bộ hẹn giờ và bộ đếm..

Đối với việc kiểm tra nội dung lỗi …
Bạn có thể dễ dàng kiểm tra nội dung lỗi dùng chức năng quan sát và chức năng kiểm

tra chương trình của HPP.

Đối với việc lưu trữ chương trình và truyền chương trình 
vào PLCs …
HPP FX-30P có thể lưu tối đa 15 chương trình tuần tự (hoặc 7 chương trình tuần tự 
nếu dung lượng của chúng nhiều hơn 32000 bước). Ngoài ra việc cập nhật chương 
trình cho các thiết bị ở xa cũng không cần thực hiện bằng máy tính.

Đối với thiết bị xuất khẩu …
HPP FX-30P có hỗ trợ tiếng Nhật, tiếng Anh và tiếng Trung Quốc, nên có thể được 
sử dụng kèm theo các sản phẩm xuất khẩu.

Phụ lục 3
Bảng Lập Trình Cầm Tay
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PLC

Bảng lập trình cầm tay
FX-30P bộ phận chính

Cáp chương trình 
FX-20P-CAB0
 (1.5 m)

Cổng lập trình

Bạn có thể dễ dàng soạn chương trình theo hình thức danh sách lệnh bằng HPP FX-30P.
HPP hỗ trợ soạn thảo chương trình và sửa lỗi thiết bị tại công trường – những nơi không 
thuận tiện trong việc cài đặt máy tính cá nhân - thông qua việc thay đổi các chương trình đơn 
giản và thông số của bộ hẹn giờ và bộ đếm.

1) Các chức năng tiện ích cho việc cài đặt thiết bị
• Soạn chương trình dùng danh sách lệnh
• Quan sát và cưỡng bức ON/OFF thiết bị

2) Chức năng tiện ích cho khắc phục lỗi
• Chức năng kiểm tra chương trình
• Chức năng chẩn đoán PLC

3) Chức năng tiện ích cho việc bảo trì
• Thay đổi các giá trị cài đặt bộ định thời và bộ đếm
• Truyền các chương trình tuần tự cập nhật
  (HPP có thể lưu đến 15 chương trình tuần tự có dung lượng 32000 bước hoặc thấp hơn).

4) Chức năng tiện ích cho thiết bị xuất khẩu
• Các thông điệp vận hành có thể được chuyển đổi giữa tiếng Anh, tiếng Hoa giản thể và tiếng  
  Nhật.

[ Ví dụ về kết nối ] [ Kích cỡ FX-30P ]

87mm

17
0m

m

Trọng lượng  : 0.3 kg

Phụ lục 3.1 Bảng lập trình cầm tay (HPP)
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[ Danh Sách Chức Năng Của FX-30P ]
■■ Chế độ Online (Chức năng vào trực tiếp bộ nhớ bên trong PLC)

Chức năng Mô tả

Lập trình

Đọc
Đọc chương trình tuần tự (từ bộ nhớ chương trình trong PLC đến màn hình
trên FX-30P).

Viết
Viết chương trình tuần tự (bằng nhập phím trong FX-30P đến bộ nhớ chương
trình trong PLC).

Chèn
Chèn lệnh vào chương trình tuần tự (bằng nhập phím trong FX-30P đến bộ nhớ
chương trình trong PLC).

Xóa
Xóa lệnh khỏi chương trình tuần tự (bằng nhập phím trong FX-30P đến bộ nhớ
chương trình trong PLC).

Quan sát Đọc trạng thái vận hành (từ bộ nhớ trong PLC đến màn hình trên FX-30P).
Kiểm tra Cưỡng bức viết thiết bị (bằng nhập phím trong FX-30P đến bộ nhớ trong PLC)

Khác

Chọn Offline Chuyển đổi chế độ Offline
Chẩn đoán PLC Chẩn đoán PLC.
Truyền qua bộ nhớ Truyền dữ liệu đến bộ nhớ.
Thông số Cài đặt thông số.
Từ khóa Cài từ khóa.
Chuyển đổi thiết bị Thực hiện chuyển đổi thiết bị.
Xóa lệnh khóa Thực hiện xóa lệnh khóa.
Quan sát nhóm thiết bị Thực hiện quan sát nhóm thiết bị
Quan sát nhóm 
BFM 

Executes buffer memory batch monitor.

Tốc độ truyền Thay đổi tốc độ truyền
Xóa bộ nhớ PLC Xóa bộ nhớ trong PLC.
 RUN/STOP từ xa Thay đổi trạng thái PLC giữa “RUN” và “STOP”.
Đặt đồng hồ PLC Cài đặt đồng hồ trên PLC.
Cài đặt HPP Cài đặt cho HPP

■■ Offline mode (Functions to access the RAM memory inside the FX-30P)
Function Description

Lập trình

Đọc Đọc chương trình tuần tự (từ RAM trong FX-30P đến màn hình trên FX-30P).
Viết Viết chương trình tuần tự (bằng nhập phím trong FX-30P đến RAM trong FX-30P).

Chèn
Chèn lệnh vào chương trình tuần tự (bằng nhập phím trong FX-30P vào RAM 
trong FX-30P).

Xóa 
Xóa lệnh khỏi chương trình tuần tự (bằng nhập phím trong FX-30P khỏi RAM 
trong FX-30P).

Khác

Chọn Online Chuyển đổi chế độ online.
Kiểm tra chương 
trình

Kiểm tra chương trình.

Truyền HPP-FX Truyền dữ liệu giữa RAM trong FX-30P và FX PLC.
Truyền HPP-PC* Truyền dữ liệu giữa RAM trong FX-30P và PC.
Thông số Cài đặt thông số.
Chuyển đổi thiết bị  Thực hiện chuyển đổi thiết bị.
Loại PLC Thay đổi loại PLC.
Xóa bộ nhớ HPP Xóa bộ nhớ trong FX-30P.
Quản lý chương trình Quản lý chương trình lưu trong RAM và bộ nhớ flash (15 khối) trong FX-30P.
Cài đặt HPP Cài đặt cho  HPP.

*: Phần cứng Ver. 1.10 hoặc mới hơn hỗ trợ truyền giữa HPP và máy tính cá nhân.

■■ Cài đặt HPP (Cài đặt chức năng cho bộ phận chính FX-30P)
Function Description

Ngôn ngữ Chọn ngôn ngữ hiển thị(Anh, Nhật và Hoa).
Âm lượng còi Điều chỉnh âm lượng còi
Độ tương phản LCD Điều chỉnh độ tương phản LCD
Độ sáng màn hình Điều chỉnh độ sáng màn hình.
Chế độ chờ Cài đặt chế độ chờ cho màn hình.
Bảo vệ HPP Cài đặt bảo vệ chương trình lưu trong FX-30P.
Khởi đầu HPP Trả FX-30P về cài đặt mặc định xuất xưởng
Cập nhật HPP F/W Cập nhật phần cứng lưu trong FX-30P.

[ Kích cỡ FX-30P ]
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Phụ lục 4
Thực hành Nối Dây
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L

N

X000

X001

X002

X003

X004

X005

X006

Y004

Y003

Y002

Y001

Y000

0 V

S/S 24 V

COM0
đến

COM2

Nguồn điện
100 V AC

Cầu dao                
Micro PLC

FX3G-14MR/ES

Đèn (đỏ)

Biến trở
Thấp   Cao

Còi

Công tắc tơ từ

Rơ le

  Van điện từ

Công tắc 
chọn

Công tắc tiệm cận

Công tắc hành
trình

Công tắc gạt

Công tắc nút nhấn

Công tắc nút nhấn

Tiếp 
điểm Động cơ

Máy Đào Tạo Loại FX-I/O-DEMO2 

 A

A 

Phụ lục 4.1 Sơ Đồ Nối Dây I/O Cho Thiết bị thực hành



155

MEMO



156

Lịch sử cập nhật manual
Ngày sản xuất Version Nội dung

Tháng 8 năm 2014 A Bản đầu tiên
Tháng 5 năm 2015 B Thay đổi nội dung ghi địa chỉ liên hệ
Tháng 7 năm 2016 C Thêm và sửa đổi các mô tả khác.





Your First PLC
   G

IỚ
I TH

IỆU
 

Làm quen với PLC...

Your First PLC
GIỚI THIỆU 

HEAD OFFICE   :  TOKYO BUILDING, 2-7-3 MARUNOUCHI, CHIYODA-KU, TOKYO 100-8310, JAPAN

JY997D57501C(MEE) Hoàn thành tháng 7 năm 2016
Thông số sản phẩm có thể được thay đổi mà không thông báo trước.

MITSUBISHI ELECTRIC VIETNAM CO., LTD.
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Tel:(08)3910 5945   Fax:(08)3910 5947
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	Phụ lục 2 Ví dụ tham khảo về Chương trình danh sách lệnh
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